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Copyright and Declaration 

 

Copyright 

SIGLENT TECHNOLOGIES CO., LTD All Rights Reserved. 

 

Trademark Information 

SIGLENT is the registered trademark of SIGLENT TECHNOLOGIES CO., LTD 

 

 

Declaration 

◆ SIGLENT products are protected by patent law worldwide 

◆ SIGLENT reserves the right to modify or change parts of or all the specifications 

or pricing policies at company’s sole decision.  

◆ Information in this publication replaces all previously corresponding material. 

◆ Any way of copying, extracting or translating the contents of this manual is not 

allowed without the permission of SIGLENT. 

◆ SIGLENT will not be responsible for losses caused by either incidental or 

consequential in connection with the furnishing, use or performance of this 

manual as well as any information contained. 

 

 

Product Certification 

SIGLENT guarantees this product conforms to the national and industrial standards in 

China as well as the ISO9001: 2008 standard and the ISO14001: 2004 standard. 

Other international standard conformance certification is in progress. 
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Safety Information 

 

General Safety Summary 

Carefully read the following safety precautions to avoid any personal injury or damage to the 

instrument and any products connected to it. To avoid potential hazards, please use the 

instrument as specified. 

 

Use Proper AC Power Line 

Only the power cord designed for the instrument and authorized by local country should be used. 

 

Ground the Instrument 

The instrument is grounded through the protective earth conductor of the power line. To avoid electric 

shock, please make sure the instrument is grounded correctly before connecting its input or output 

terminals. 

 

Connect the Probe Correctly.  

If a probe is used, do not connect the ground lead to high voltage since it has isobaric electric potential 

as the ground.  

 

Look Over All Terminals’ Ratings 

To avoid fire or electric shock, please look over all ratings and sign instruction of the instrument. Before 

connecting the instrument, please read the manual carefully to gain more information about the ratings. 

 

Use Proper Overvoltage Protection 

Make sure that no overvoltage (such as that caused by a thunderstorm) can reach the product, or else 

the operator might be exposed to danger of electrical shock. 

 

Electrostatic Prevention 

Operate the instrument in an electrostatic discharge protective area environment to avoid damages 

induced by static discharge. Always ground both the internal and external conductors of the cable to 

release static before connecting. 

 

Maintain Proper Ventilation 

Inadequate ventilation may cause increasing of the instrument’s temperature, which will eventually 

damage the instrument. So keep well ventilated and inspect the intake and fan regularly. 

 

Avoid Exposed Circuit or Components  

Do not touch exposed contacts or components when the power is on. 
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Do Not Operate Without Covers 

Do not operate the instrument with covers or panels removed. 

 

Use proper Fuse. 

Use only the specified fuse. 

 

Keep Product Surfaces Clean and Dry.  

To avoid the influence of dust and/or moisture in the air, please keep the surface of the device clean 

and dry.  

 

Do Not Operate in Wet Conditions.  

In order to avoid short circuiting to the interior of the device or electric shock, please do not operate the 

instrument in a humid environment.  

 

Do Not Operate in an Explosive Atmosphere. 

In order to avoid damage to the device or personal injury, it is important to operate the device away 

from an explosive atmosphere.  

 

Any parts of the device and its accessories are not allowed to be changed or replaced, other than 

authorized by the manufacturer or his agent. 

Make sure not to position the equipment so that it is difficult to operate the disconnecting device 

(detachable plug). 

 

 

 

Safety Terms and Symbols 

Terms in this Manual. These terms may appear in this manual:  

  

WARNING  

Warning statements indicate the conditions or practices that could 

result in injury or loss of life. 

 

 

CAUTION 

Caution statements indicate the conditions or practices that could 

result in damage to this product or other property.  

 

 

Terms on the product. 

DANGER   Indicates direct injuries or hazards that may happen. 

WARNING  Indicates potential injuries or hazards that may happen. 

CAUTION   Indicates potential damages to the instrument or other property that may happen. 
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Symbols on the product. 

               

Hazardous    protective Earth    Warning           Test        Power Switch 

 Voltage         Terminal                          Ground 

 

If find such symbols on the product, consult the manual to find out the nature of the potential 

hazard and the actions which have to be taken 

 

 

Measurement Category 

Measurement Categories 

This analyzer can make measurements in other circuits that are not directly connected to mains. 

 

WARNING  

This analyzer can only be used for measurements within its specified measurement 

categories. 

     Not to use the product for measurements within other measurement 

           categories, such as CAT II, CAT III, CAT IV. 

           Not to use the equipment for measurements on mains circuits 

 

 

Measurement Category Definitions  

Measurement category II is for measurements performed on circuits directly connected to the low 

voltage installation. Examples are measurements on household appliances, portable tools and 

similar equipment.  

 

Measurement category III is for measurements performed in the building installation. Examples 

are measurements on distribution boards, circuit-breakers, wiring, including cables, bus-bars, 

junction boxes, switches, socket-outlets in the fixed installation, and equipment for industrial use 

and some other equipment, for example. Stationary motors with permanent connection to the fixed 

installation. 

  

Measurement category IV is for measurements performed at the source of the low-voltage 

installation. Examples are electricity meters and measurements on primary over current protection 

devices and ripple control units. 
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Working Environment 

Temperature 

Operating: 0℃ to +40℃ 

Non-operation: -20℃ to +70℃ 

 

Humidity  

Under +35℃: ≤80% relative humidity 

+35℃ to +40℃: ≤60% relative humidity 

 

 

WARNING  

To avoid short circuit inside the instrument or electric shock,  

please do not operate in humid environment.  

 

 

Altitude  

Operating: less than 3 km 

Non-operation: less than 15 km 

 

Degree of protection 

IP20 

 

Installation (overvoltage) Category 

This product is powered by mains conforming to installation (overvoltage) category II. 

 

 

WARNING  

Make sure that no overvoltage (such as that caused by thunderbolt) can reach the 

product, or else the operator might expose to danger of electric shock.  

 

 

Installation (overvoltage) Category Definitions  

Installation (overvoltage) category I refers to signal level which is applicable to equipment 

measurement terminals connected to the source circuit. In these terminals, precautions are done 

to limit the transient voltage to the corresponding low level.  

 

Installation (overvoltage) category II refers to the local power distribution level which is applicable 

to equipment connected to the AC line (AC power). 

 

 

 



                                                                             SIGLENT 

SSA3000X User Manual VII  

Ventilation Requirement  

This analyzer uses fan to force cooling. Please make sure that the air intake and exhaust areas 

are free from obstructions and have free air. When using the analyzer in a bench-top or rack 

setting, provide at least 10 cm clearance beside, above and behind the instrument for adequate 

ventilation.  

 

WARNING  

Inadequate ventilation may cause temperature increase which would damage the 

instrument. So please keep the instrument well ventilated during operation and 

inspect the intake and fan regularly. 

 

 

 

General Care and Cleaning 

Care  

Do not store or leave the instrument in direct sunshine for long periods of time. 

 

WARNING  

To avoid damages to the instrument or probe, please do not leave them in fog, liquid, 

or solvent. 

 

 

Cleaning 

Please perform the following steps to clean the instrument and probe regularly according to its 

operating conditions.  

1. Disconnect the instrument from all power sources, and then clean it with a soft wet cloth. 

2. Clean the loose dust on the outside of the instrument and probe with a soft cloth. When 

cleaning the LCD, take care to avoid scarifying it. 

 

 

WARNING  

To avoid damages to the surface of the instrument and probe, please do not use any 

corrosive liquid or chemical cleanser. 

 

 

WARNING  

Make sure that the instrument is completely dry before restarting it to avoid short 

circuits or personal injuries. 
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L'information de sûreté 

 

Résumé général de sûreté 

Lisez soigneusement les mesures de sécurité suivantes pour éviter n'importe quelles blessures ou 

les dommages à l'instrument et à tous les produits se sont reliés à eux. Pour éviter des risques, 

utilisez svp l'instrument comme indiqué. 

 

Employez la ligne à haute tension appropriée 

Seulement le cordon de secteur conçu pour l'instrument et autorisé par le pays local a pu être 

employé. 

 

A rectifié l'instrument. 

L'instrument est fondu par le conducteur protecteur de terra de la ligne à haute tension. Pour 

éviter la décharge électrique, le conducteur moulu doit être relié à la terre. Assurez-vous que 

l'instrument est fondu correctement avant de relier ses bornes d'entrée ou de rendement. 

 

Reliez le fil de signal correctement. 

Le potentiel de l'au sol de fil de signal est égal à la terre, ainsi ne relie pas le fil de signal à une 

tension. 

 

Regardez estimations au-dessus de toutes les bornes des' 

Pour éviter le feu ou la décharge électrique, regardez svp au-dessus de toutes les estimations et 

instruction de signe de l'instrument. Avant de relier l'instrument, lisez svp le manuel 

soigneusement pour obtenir plus d'informations sur les estimations. 

 

Employez la protection appropriée de surtension 

Assurez-vous qu'aucune surtension (comme cela provoqué par un orage) ne peut atteindre le 

produit, ou bien l'opérateur pourrait exposer au danger du choc électrique. 

 

Empêchement électrostatique 

Fonctionnez dans un environnement protecteur de secteur de décharge électrostatique pour 

éviter des dommages induits par décharge statique. A toujours rectifié les conducteurs internes et 

externes du câble pour libérer la charge statique avant de se relier. 

 

La ventilation insatisfaisante de ventilation 

bonne de subsistance peut causer l'augmentation de la température, qui endommagera par la 

suite l'instrument. Gardez ainsi la ventilation bonne et inspectez la prise et éventez régulièrement. 

 

Évitez le circuit ou les composants exposés 

ne touchent pas les contacts ou les composants exposés quand le courant passe. 



                                                                             SIGLENT 

SSA3000X User Manual IX  

 

Employez l'utilisation appropriée 

de fusible seulement le fusible indiqué. 

 

Ne fonctionnez pas sans couvertures 

n'actionnent pas l'instrument des couvertures ou des panneaux étant coupés. 

 

Ne fonctionnez pas avec des échecs suspectés.  

Si vous suspectez les dommages se produisent à l'instrument, l'ont inspecté par le personnel de 

service qualifié avant d'autres opérations. N'importe quel entretien, ajustement ou remplacement 

particulièrement aux circuits ou aux accessoires doivent être exécutés par le personnel autorisé 

par SIGLENT. 

 

Ne fonctionnez pas en conditions humides.  

Afin d'éviter de court-circuiter à l'intérieur du dispositif ou de la décharge électrique, svp ne 

fonctionnez pas dans un environnement humide.  

 

Do Not Operate in an Explosive Atmosphere.  

Ne fonctionnez pas dans une atmosphère explosive.  

Afin d'éviter d'endommager le dispositif ou les blessures, il est important d'utiliser le dispositif loin 

à partir d'une atmosphère explosive.  

 

Maintenez les surfaces de produit propres et sèches.  

Pour éviter l'influence de la poussière et/ou de l'humidité en air, maintenez svp la surface du 

dispositif propre et sèche. 

 

En manipulant la sûreté  

manipulez svp avec soin pendant le transport pour éviter d'endommager des boutons, des 

interfaces de bouton et d'autres parties sur les panneaux. 

 

Le corps ou l'opérateur responsable devrait se référer au manuel d'instruction pour préserver la 

protection se permettent par l'équipement. Si l'équipement est utilisé en quelque sorte non indiqué 

par le fabricant, la protection fournie par l'équipement peut être altérée. 

 

On ne permet à aucune pièce du dispositif et de ses accessoires d'être changé ou remplacé, autre 

qu'autorisé par le fabricant ou son agent. 

Pas placez l'équipement de sorte qu'il soit difficile d'utiliser le dispositif débranchant (prise 

détachable). 
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Limites et symboles de sûreté 

Limites en ce manuel. Ces limites peuvent apparaître en ce manuel : 

 

Les rapports  

 d'avertissement D'AVERTISSEMENT indiquent les conditions ou les 

pratiques qui pourraient avoir comme conséquence les dommages ou la                                      

           perte de la ie. 

 

 

Les rapports 

d'attention d'ATTENTION indiquent les conditions ou les pratiques qui 

pourraient avoir comme consequenceles dommages à ce produit ou à  

           toute autre propriété.  

 

 

 

 

Limites sur le produit. Ces limites peuvent apparaître sur le produit : 

 

Le DANGER indique les dommages ou les risques directs qui peuvent se produire. 

Dommages ou risques potentiels de WARNINGIndicates qui peuvent se produire. 

 

L'ATTENTION indique des dommages potentiels à l'instrument ou à toute autre propriété qui 

peuvent se produire. 

 

Si la trouvaille de tels symboles sur le produit, consultent le manuel pour découvrir la nature du 

risque et des actions qui doivent être pris. 

 

 

 

Symboles sur le produit. Ces symboles peuvent apparaître sur le produit : 

 

 

Dangereux   Protecteur      Avertissement    Châssis    Puissance 

Tension      Au sol de la terre                Ground    Switch 
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Catégorie de mesure 

 

Les analyzers peuvent faire des mesures dans d'autres circuits qui ne sont pas directement reliés 

aux forces. Pour ne pas employer le produit pour des mesures dans d'autres catégories de 

mesure, telles que le CAT II, CAT III, CAT IV. 

Ne pas utiliser l'équipement pour des mesures sur des forces circuite, pour ne pas utiliser 

l'équipement pour des mesures sur la tension excèdent la gamme de tension décrivent dans le 

manuel. 

 

Les rapports  

 cet analyzers peut seulement être employé pour des mesures dans   

 ses catégories indiquées de mesure. 

 

 

 

La catégorie II de mesure 

 

de définitions de catégorie de mesure est pour des mesures effectuées sur des circuits 

directement reliés à l'installation de basse tension. Les exemples sont des mesures sur des 

appareils électroménagers, des outils portatifs et l'équipement semblable.  

 

La catégorie III de mesure est pour des mesures effectuées dans l'installation de bâtiment. Les 

exemples sont des mesures sur des conseils de distribution, des disjoncteurs, le câblage, y 

compris des câbles, des barres omnibus, des boîtes de jonction, des commutateurs, des 

douille-sorties dans l'installation fixe, et l'équipement à l'utilisation industrielle et à un autre 

équipement, 

 

par exemple. Moteurs stationnaires avec le raccordement permanent à l'installation fixe. 

La catégorie IV de mesure est pour des mesures effectuées à la source d'installation de basse 

tension.Les exemples sont des mètres et des mesures de l'électricité sur les dispositifs de 

protection d'excédent primaire et les unités de commande courants d'ondulation. 
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Environnement de fonctionnement 

Température  

En fonctionnement: 0 à + 40  

Non-fonctionnement: -20 à + 70  

 

Humidité  

Moins de + 35: humidité relative ≤80%  

+ 35 à + 40 ℃: humidité relative ≤60% 

 

EN AVERTISSANT 

d'éviter le court-circuit à l'intérieur de l'instrument ou de la décharge électrique, svp ne 

fonctionnez pas dans l'environnement humide.  

 

Opération  

d'altitude : moins de 3 kilomètres 

de non-fonctionnement : moins de 15 kilomètres 

 

Degré de protection 

IP20 

 

La catégorie d'installation (surtension) 

ce produit est actionnée par des forces conformément à la catégorie II. d'installation (surtension). 

 

 

EN AVERTISSANT 

assurez-vous qu'aucune surtension (comme cela provoqué par coup de 

foudre) ne peut atteindre le produit, ou bien l'opérateur pourrait 

 exposer au danger de la décharge électrique.  

 

La catégorie II d'installation de définitions de catégorie d'installation (surtension) (surtension) se 

rapporte au niveau local de distribution d'énergie qui est applicable à l'équipement relié à la ligne à 

C.A. (courant alternatif). 

 

 

Condition de ventilation 

This analyzer uses fan to force cooling. Please make sure that the air intake and exhaust areas 

are free from obstructions and have free air. When using the analyzer in a bench-top or rack 

setting, provide at least 10 cm clearance beside, above and behind the instrument for adequate 

ventilation.  
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Cet analyzer utilise le ventilateur pour forcer le refroidissement. Veuillez s'assurer que les 

secteurs d'entrée et d'échappement d'air sont exempts des obstructions et ont l'air libre. À l'aide 

de l'analyzer dans un mettre hors jeu-dessus ou un arrangement de support, fournissez au moins 

le dégagement de 10 centimètres près, au-dessus et derrière de l'instrument pour à ventilation 

proportionnée. 

 

 

La ventilation insatisfaisante peut causer l'augmentation de la température qui 

endommagerait l'instrument. Veuillez ainsi la subsistance l'instrument bien aéré lors 

du fonctionnement et inspectez la prise et éventez régulièrement. 

 

 

Soin général et nettoyage 

Ne stockez pas ou ne laissez pas l'instrument en soleil direct pendant de longues périodes. 

 

 

Pour éviter d'endommager l'instrument, svp ne les laissez pas dans le brouillard, le 

liquide, ou le dissolvant. 

 

 

nettoyage 

Veuillez exécuter les étapes suivantes pour nettoyer l'instrument régulièrement selon ses 

conditions de fonctionnement. 

 

1. Démontez l'instrument de toutes les sources d'énergie, et puis nettoyez-le avec un tissu humide 

mou. 

2. Nettoyez la poussière lâche sur l'extérieur de l'instrument avec un tissu mou. En nettoyant 

l'affichage à cristaux liquides, salut pour éviter de le scarifier. 

 

 

 

Pour éviter d'endommager la surface de l'instrument, svp n'utilisez aucune épierreuse 

corrosive de liquide ou de produit chimique. 

 

 

 

 

Assurez-vous que l'instrument est complètement sec avant de le remettre en marche 

pour éviter des courts-circuits ou des blessures. 
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Allgemeine Sicherheitshinweise 

Um Verletzungen oder Schäden am Gerät und den damit verbundenen Produkten zu vermeiden, 

lesen Sie die folgenden Sicherheitshinweise sorgfältig durch. 

Um mögliche Gefahren zu vermeiden, verwenden Sie bitte das Gerät wie angegeben. 

Wartungsarbeiten an diesem Gerät dürfen nur von qualifiziertem Reparaturpersonal 

durchgeführt werden. 

 

Verwendung eines geeigneten Netzkabels 

Verwenden Sie nur das für das Gerät vorgesehene und von den örtlichen Behörden zugelassene 

Netzkabel.  

Erdung des Gerätes 

Das Gerät ist über den Schutzleiter des Netzkabels geerdet. Um einen elektrischen Schlag zu 

vermeiden, vergewissern Sie sich bitte, bevor Sie seine Eingangs- oder Ausgangsklemmen 

anschließen, dass das Gerät korrekt geerdet ist.  

Anschluss der Signalleitung 

Die Masse der Signalleitung ist auf dem gleichen Potential wie die Erdung des Gerätes. Schließen Sie 

daher die Masseleitung nie an eine Hochspannung an. Berühren Sie keine freiliegenden Kontakte 

oder Komponenten. 

Verschaffen Sie sich einen Überblick über alle Anschluss-Ratings 

Um Brände oder Stromschläge zu vermeiden, lesen Sie bitte alle Bemerkungen und Anweisungen des 

Gerätes. Bevor Sie das Gerät anschließen, lesen Sie bitte das Handbuch sorgfältig durch, um weitere 

Informationen über die Nennleistungen zu erhalten.  

Betreiben Sie kein Gerät, bei dem der Verdacht besteht, dass es defekt ist. 

Wenn Sie vermuten, dass das Produkt beschädigt ist, lassen Sie es bitte von qualifiziertem 

Fachpersonal überprüfen. Vermeiden Sie den Kontakt mit freiliegenden Stromkreisen oder Drähten. 

Berühren Sie keine freiliegenden Kontakte oder Komponenten, wenn das Gerät eingeschaltet ist. 

Verwenden Sie einen geeigneten Überspannungsschutz 

Stellen Sie sicher, dass keine Ü berspannung (z.B. durch ein Gewitter) auf das Produkt gelangen kann, 

da sonst der Bediener der Gefahr eines Stromschlags ausgesetzt sein kann.  

Nicht ohne Abdeckungen betreiben 

Betreiben Sie das Gerät nicht bei abgenommenen Abdeckungen oder Platten. 

Halten Sie die Oberfläche des Gerätes sauber und trocken. 

 

Nicht unter nassen/feuchten Bedingungen betreiben. 

 

Betreiben Sie das Gerät nicht in einer explosiven Atmosphäre. 
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Vermeiden Sie es, dieses Gerät einem Feuer auszusetzen. 

 

Sicherheitshinweise und Symbole 

 

In diesem Produkt verwendete Begriffe. Diese Begriffe können im Produkt erscheinen:  

GEFAHR  weist auf eine mögliche, sofortige und direkte Verletzung oder Gefährdung hin.  

WARNUNG  weist auf möglicherweise auftretende Verletzungen oder Gefahren hin 

VORSICHT  weist auf möglicherweise auftretende Schäden am Gerät oder anderen 

Gegenständen  

hin  

 

In diesem Produkt verwendete Symbole. Diese Symbole können auf dem Produkt erscheinen: 

   

 Gefährliche      Schutzerde     Sicherheitswarnung      Erdung        Netzschalter 

  Spannung                         
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Chapter 1 Quick Start  

This chapter guides users to quickly get familiar with the appearance, dimensions, front/rear panel and 

the user interface, as well as announcements during first use of the analyzer.  

 

Subjects in this chapter:  

 

◆ General Inspection 

◆ Appearance and Dimension  

◆ Preparing for Use  

◆ Front Panel  

◆ Rear Panel  

◆ Display Annotations  

◆ Firmware Operation 

◆ Menu Operation 

◆ Parameter Setting 

◆ Using Built-in Help 

◆ Using the Security Lock  
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1.1 General Inspection 

1. Inspect the shipping container 

Keep the damaged shipping container or cushioning material until the contents of the shipment have 

been completely checked and the instrument has passed both electrical and mechanical tests. 

The consigner or carrier will be responsible for damages to the instrument resulting from shipment. 

SIGLENT will not provide free maintenance or replacement. 

 

2. Inspect the instrument 

If the instrument is found to be damaged, defective or fails in electrical or mechanical tests, please 

contact SIGLENT. 

 

3. Check the accessories 

Please check the accessories according to the packing list in the box. If the accessories are incomplete 

or damaged, please contact your SIGLENT sales representative. 

 

1.2 Appearance and Dimension 

 

Figure 1-1 Front View 

 

Figure 1-2 Top View 
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1.3 Preparing for Use  

1.3.1 Adjust the Supporting Legs 

Adjust the supporting legs properly to use them as stands to tilt the Spectrum Analyzer upwards for 

stable placement as well as easier operation and observation of the instrument. 

                

Figure 1-3 Before adjusting            Figure1-4 After adjusting 

 

1.3.2 Connect to AC Power Supply 

The spectrum analyzer accepts 100-240V, 50/60 or 100-120VA 400Hz AC power supply. Please use 

the power cord provided as accessories to connect the instrument to the power source as shown in the 

figure below. Before power on, make sure the spectrum analyzer is protected by fuse. 

 

 

 

Figure 1-5 Power Cord Connection 

The Plug 

The Fuse 
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1.4 Front Panel 

 

Figure 1-6 the Front Panel 

Table 1-1 Front Panel Description  

NO. Description NO. Description 

1 User Graphical Interface 2 Menu Control Keys 

3 Function Keys 4 Knob 

5 Arrow Keys 6 RF Input 

7 Numeric Keyboard 8 TG Output 

9 Earphone interface 10 USB Host 

11 Power Switch   

1.4.1 Front Panel Function Keys  

 

Figure 1-7 Function Keys area 
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Table 1-2 Function keys description  

Control Keys Description 

Frequency Set the parameters of frequency, and Peak→CF, CF→Step. 

Span Set the parameters of span, and X-scale (Log-Linear) setup. 

Amplitude Set the parameters of amplitude, including Ref Level, Attenuator, Preamp, etc; and 

Correction setup. 

Auto Tune Scan the full span rapidly and move the biggest signal to center freq, and 

automatically sets the optimal parameters according to the signal. 

Control Keys Description 

BW Set the parameters of RBW and VBW, Average Type (Log power, Power, Voltage), 

and Filter Type (-3 dB Gauss\ -6 dB EMI). 

Trace Select Trace, Trace setup and Trace math. 

Sweep Set the parameters of sweep, and EMI QPD Dwell Time. 

Detect Select the Detector type for each trace independently. 

Trigger Select triggers in Free Trigger, Video Trigger and External Trigger. 

Limit Set the Pass\Fail Limit. 

TG Set the parameters of tracking generator. Including TG Level, TG level offset, 

Normalization setup. The backlight LED is on when TG source is on. 

Demod Set the demodulation parameters of the AM and FM for audio listening 

Marker Keys Description 

Marker Set the Markers and Marker Table 

Marker-> Set other system parameters on the basis of the current marker value. 

Marker Fn Special functions of the marker such as noise marker, N dB bandwidth measurement 

and frequency counter. 

Peak Search for the peak signal, peak search configuration and peak table. 

Meas Keys Description 

Meas In spectrum analyzer mode, select the Advanced Measurement function 

In non spectrum analyzer mode, select corresponding settings. 

Meas Setup Set the measurement parameters. 

System Keys Description 

System Set the system parameters 

Mode Select the working modes. 

Display Set the display parameters. 

File Use the file system and files 

Shortcut Keys Description 

Preset Sets the system to certain status 

Couple Set the parameters of some functions between auto and manual. 

Help Turn on the built-in help 

Save Save Shortcut Key  
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1.4.2 Front Panel Key Backlight  

The on/off state and the color of the backlights of some keys at the front panel indicate the working 

state of the spectrum analyzer. The states are as listed below.  

1. Power Switch  

◆ Flash on and off alternatively, in breathing state: indicate the unit is in stand-by state.  

◆ Constant on: indicate the instrument is in normal operating state.  

 

2. Mode 

When the function is Spec Analyzer, the backlight is turn off. When in the other mode, the backlight of 

Mode turns on. 

 

3. TG 

When the TG source is on, the backlight of TG turns on and turns off when the function is off.  

1.4.3 Using the Numeric Keyboard  

The analyzer provides a numeric keyboard at the front panel. The numeric keyboard which supports 

English uppercase/lowercase characters, numbers and common symbols (including decimal point, #, 

space and +/-) are mainly used to edit file or folder name and set parameters.  

 

Figure 1-8 Numeric Keyboards 

 

1. +/- 

In number input, set the sign of number; in file input, switch in number and letter. 

 

2. 1 A/a 

In number input, enter number 1; in file input, switch between uppercase and lowercase letter. 

 

3. . # 

In number input, a decimal point. In English input, special character.  

 

4. Back 

In parameter editing, press this key to delete the character on the left of the cursor.  
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5. Esc 

◆ During parameter editing process, press this key to clear the inputs in the active function area and 

exit parameter input.  

◆ When the instrument is in remote mode, use this key to return to local mode.  

 

6. Enter 

In parameter editing, the system will complete the input and insert a default unit for the parameter.  

1.4.4 Front Panel Connectors  

 

Figure 1-9 Front Panel Connectors (1) 

1. Power Switch  

Power up / Power down the instrument.  

 

2. USB Host  

◆ The analyzer can serve as a “host” device to connect external USB devices. This interface is 

available for USB storage devices.  

◆ Read and store the instrument state or trace in the USB storage device or store the contents 

currently displayed on the screen in the USB storage device in .png or .jpg or .bmp format.  

 

3. Earphone Jack  

The analyzer provides AM and FM demodulations. Insert a 3.5 mm earphone to the jack to acquire the 

audio output of the demodulated signal. You can turn on or off the earphone output and adjust the 

volume via Demod ->Volume. 

 

 
CAUTION 

Protect your hearing. Please turn the volume down to zero before using the 

earphone. Gradually turn the volume up to a comfortable level after putting 

in the earphone..  
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Figure 1-10 Front Panel Connectors (2) 

 

4. TG SOURCE 

The TG SOURCE can be connected to a receiver through a cable with an N-male connector.  

 

 
CAUTION 

To avoid damage to the tracking generator, the reverse DC voltage cannot 

exceed 50 V 
 

 

5. RF INPUT 

The RF INPUT can be connected to a DUT through a cable with an N-male connector. 

 

 
CAUTION 

To avoid damage to the instrument, for the signal input from the RF input 

terminal, the DC voltage component and the maximum continuous power of 

the AC (RF) signal component cannot exceed 50 V and +30 dBm 

respectively.  
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1.5 Rear Panel  

 

Figure 1-11 Rear Panel 

 

1. Handle 

Pull up the handle vertically for easy carrying of the instrument. When you do not need the handle, 

press it down.  

 

2. USB Device Interface 

The analyzer can serve as a “slave” device to connect external USB devices. Through this interface, a 

PC can be connected to control the analyzer remotely through programming or PC software. 

 

3. LAN Interface 

Through this interface, the analyzer can be connected to your local network for remote control.  

 

4. REF IN 10MHz 

The analyzer can use internal or external reference source.  

◆ When a 10 MHz external clock signal is received through the [10MHz IN] connector, this signal is 

used as the external reference source and “Ext Ref” is displayed in the status bar of the user 

interface. When the external reference is lost, transfinite or not connected, the instrument switches 

to its internal reference source automatically and “Ext Ref” on the screen disappears.  

◆ The [10MHz IN] and [10MHz OUT] connectors are usually used to build synchronization among 

multiple instruments.  

 

5. REF OUT 10MHz 

The analyzer can use internal or external reference source.  

◆ When internal reference source is used, the [10MHz OUT] connector can output a 10 MHz clock 
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signal generated by the analyzer. This signal can be used to synchronize other instruments.  

◆ The [10MHz OUT] and [10MHz IN] connectors are usually used to build synchronization among 

multiple instruments.  

 

6. Trigger in 

In external trigger mode, the connector receives an external trigger signal through a BNC cable. 

 

7. Security Lock Hole  

If needed, you can use a security lock (buy it yourself) to lock the analyzer to a desired location.  

 

8. AC Power Supply and Fuse 

The spectrum analyzer accepts 100-240V, 50/60 or 100-120VA 400Hz power supply. Please use the 

power cord provided as accessories to connect the instrument. Before power on, make sure the 

spectrum analyzer is protected by fuse. 
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1.6 Display Annotations 

 
Figure 1-12 User Interface 

 

Table 1-3 User Interface labels 

NO. Name Description  
 

1 SIGLENT Logo of SIGLENT 

2 Ref Reference level 

3 UNCAL When the sweep time less than the auto couple time, the 

measure result may be inaccuracy, then appear “UNCAL” 

4 Active function area Current parameter and its value 

5 EXT REF Ext 10 MHz reference clock detected indicator 

6 Att  Attenuator Value 

7 Day and time System time 

8, 9, 11 Maker parameter 8:current active marker;  

9:current marker frequency value; 

11:current marker amplitude value; 

10 Auto Tune Automatically sets the optimal parameters 

12 USB storage device 

identification 

The identification is displayed when a USB disk is inserted 

13 Menu title Function of the current menu. 

14 Menu items Menu items of the current function 

15 Operation status Local is local mode, Remote is remote mode, Upgrade  
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means the instrument is upgrading 

16 Sweep time Sweep time 

17 Span/Stop Frequency The frequency range of the current sweep 

18 Sweep progress bar Sweep progress bar 

19 Pass/Fail status Pass/Fail status 

20 VBW Video bandwidth 

21 Spectrum trace Spectrum trace 

22 RBW Resolution bandwidth 

23 Center/Start frequency The frequency range of the current sweep 

24, 25, 26,    

27 

Trace  

A\B\C\D  

status 

Trace type: 

C&W: Clear Write 

MaxH: Max Hold 

MinH: Min Hold 

View: View 

AVG: Video average. 

Detect type:  

P-PK: Positive peak 

N-PK: Positive peak 

Samp: Sample 

Norm: Normal 

AVG: average 

Q-PK: Quasi-peak 

28 AM or FM AM or FM identification 

29 PA Enable or disable Preamplifier 

30 FFT Sweep mode is FFT 

31 Single or Continue Sweep mode single or continue 

32 Average type Log power, Power, Voltage 

33 Trigger type Free, Video, External trigger 

34, 35 Ref offset 34：Ref offset identification; 

35：Ref offset value 

36 Scale/Div Scale value 

37 Scale type Logarithm or linearity 

 

1.7 Firmware Operation 

1.7.1 Check System Information  

Users can get the system information by press System->“System Info”, including 

◆ Product Model, Serial and Host ID 

◆ Software Version and Hardware Version 

◆ Option Information 

1.7.2 Load Option 

Refer to the procedures below to activate the options you have purchased. 

1, Press System ->“Load Option”  

2, Enter the license key in the onscreen window. Press Enter to confirm your input and terminate the 

license key input. Or 
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3, Load the .lic file provided by pressing File ->“Load” from internal memory or USB stick. 

The option will be enabled after rebooting. 

1.7.3 Firmware Upgrade 

Follow this procedure to update the instrument firmware: 

1. Download the firmware package from an official SIGLENT website. www.siglentamerica.com,  

http://www.siglent.com/ens,  https://www.siglenteu.com 

2. Extract and copy the .ADS file into the root directory of a USB stick. 

3. Plug the USB stick into the USB Host connector. Press System->“System Info”-> “Firmware 

Update”; find the .ADS file in USB stick. 

4. Press the “Load”, the analyzer will perform the update process automatically. 

Remarks: 

◆ The upgrade process will take several minutes. When the upgrade is completed, the machine will 

reboot. 

◆ Any interruption during the update process will result in update failure and system data loss. This 

is not covered under the warranty and the user will bear repair costs and shipping. 

◆ Do not remove the USB storage device until the update is finished. 

 

1.8 Menu Operation 

There are 7 types of menus according to their operation modes. Each type of menu and its operation 

method are introduced below.  

 

1. Parameter Input  

When selected, use the numeric keys to modify the parameters.  

For example, select Center Freq, input the desired figure and press Enter 

to change the center frequency.  

 

2. State switching 

Press the corresponding menu key to switch between the sub-options.  

For example, press Preamp to enable or disable the amplifier. 

 

3. Enter Lower Menu(with parameter) 

Press the corresponding menu key to enter the lower menu and change the 

option currently selected.  

For example, press Units to enter the lower menu. Select dBm and return 

to the previous menu. The unit of Y-axis changes to dBm.  

4. Enter Lower Menu (without parameter) 

Press the corresponding menu key to enter the lower menu.  

For example, press Calibration to enter the lower menu directly.  

 

5. Direct Execution 

http://www.siglentamerica.com/
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Press the key to execute the corresponding function.  

For example, press Peak->CF to execute a peak search and set the 

center frequency of the analyzer to the frequency of the current peak 

signal.  

6. Function Switch + Parameter Input  

Press the corresponding menu key to switch between functions; change 

the parameter directly using the numeric keys.  

For example, press Freq Step to switch between Auto and Manual; if 

Manual is selected, you can directly input the desired number to change 

the Freq Step.  

7. State Selection 

Press the corresponding menu key to modify the parameter and return to 

the menu one level up.  

For example, press Trig Type ->Free Run to select free trigger and the 

analyzer is in Free Run state at present.  

 

1.9 Parameter Setting  

Users can enter the desired parameter values using the numeric keys, knob or Arrow keys. This 

section describes the three methods of parameter setting through an example (to set the center 

frequency to 100 MHz).  

 

1. Use the numeric keyboard  

◆ Press Frequency->“Center Freq” 

◆ Input 100 using the numeric keys;  

◆ Select the desired unit (MHz) from the popup menu.  

 

2. Use the knob  

When the parameter is editable (namely when the parameter is selected), turn the knob clockwise to 

increase or counterclockwise to decrease the parameter value at the specified step.  

◆ Press Frequency->“Center Freq” 

◆ Rotate the knob until the parameter is set to the desired value (100 MHz).  

 

Figure 1-13 Knob 

3. Use the arrow keys 

When the parameter is editable (namely when the parameter is selected), you can increase or 

decrease the parameter value at the specific step using the direction keys.  

◆ Press Frequency -> “Center Freq” 

◆ Press the up/down Arrow key until the parameter is set to the desired value (100 MHz).  
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1.10 Using Built-in Help  

The built-in help system provides information about every function key at the front panel and every 

menu soft key.  

◆ Press Help and a prompt about how to obtain help information will be shown at the center of the 

screen. Then, press the key that you want to get help of and the relevant help information will be 

shown at the center of the screen.  

◆ When the help information show at the center of the screen. Press the Help button; it will close the 

help information.  

 

Figure 1-14 help information 

1.11 Using the Security Lock  

If needed, you can use the security lock (please buy it yourself) to lock the Spectrum Analyzer to a fixed 

location. The method is as follows, align the lock with the lock hole and plug it into the lock hole 

vertically, turn the key clockwise to lock the Spectrum Analyzer and then pull the key out. 

 

 

Figure 1-15 Security Lock 
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Chapter 2 Front Panel Operation  

This chapter describes in detail the function keys at the front panel and the associated functions.  

  

Subjects in this chapter: 

 

◆ Basic Settings  

◆ Sweep and Function  

◆ Marker 

◆ Measurement 

◆ System 

◆ Shortcut Key 
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2.1 Basic Settings 

2.1.1 Frequency 

Set the frequency parameters and functions of the analyzer. Restart sweeping every time when the 

frequency parameters are modified.  

 

The frequency range of a channel can be expressed by either of three groups of parameters: Start 

Frequency, Center Frequency and Stop Frequency. If any of the parameters is changed, the others 

would be adjusted automatically in order to ensure the coupling relationship among them 

startstopspan

stopstartcenter

fff

)/2f(ff

−=

+=
 , The spanf  is span. 

2.1.1.1 Center Frequency 

Set the center frequency of the current channel. The center frequency and span values are displayed 

at the lower left and right sides of the grid respectively. In process of using pay attention to the 

following points: 

◆ The start and stop frequencies vary with the center frequency when the span is constant (except 

the Start Frequency and Stop Frequency to the border).  

◆ In Zero Span, the start frequency, stop frequency and center frequency are always the same. 

 

Table 2-1 Center Frequency 

Parameter Explanation 

Default Full Span/2 

Range Zero Span, 0 Hz ~ Full Span 

Nonzero Span, 50 Hz ~ (Full Span -50Hz) 

Unit GHz\MHz\kHz\Hz 

Knob Step Span>0, step=Span/200 

Span=0, step=RBW/100 

Min 1 Hz 

Direction Key Step Freq step 

Related to Start Freq, Stop Freq 

2.1.1.2 Start Frequency  

Set the start frequency of the current channel. The start and stop frequencies are displayed at the 

lower right sides of the grid respectively. In process of using pay attention to the following points:  

◆ The span and center frequency vary with the start frequency when the Span did not reach the 

minimum (The parameters vary with the span, please refer to “Span”); 

◆ In Zero Span, the start frequency, stop frequency and center frequency are always the same. 
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Table 2-2 Start Frequency 

Parameter Explanation 

Default 0 GHz 

Range Zero Span, 0 Hz ~ Full Span 

Nonzero Span, 0 Hz ~ (Full Span-100Hz) 

Unit GHz\MHz\kHz\Hz 

Knob Step Span>0, step=Span/200 

Span=0, step=RBW/100 

Min 1 Hz 

Direction Key Step Freq step 

Related to Center Freq, Span 

2.1.1.3 Stop Frequency 

Set the stop frequency of the current channel. The start and stop frequencies are displayed at the 

lower right sides of the grid respectively. In process of using pay attention to the following points: 

◆ The span and center frequency vary with the stop frequency. The charge of span would affect 

other system parameters. For more details, please refer to “Span”. 

◆ In Zero Span mode, the start frequency, stop frequency and center frequency are always the 

same. 

 

Table 2-3 Stop Frequency 

Parameter Explanation 

Default Full Span 

Range Zero Span: 0 Hz ~ Full Span 

Nonzero Span: 100 Hz ~ Full Span 

Unit GHz, MHz, kHz, Hz 

Knob Step Span>0, step=Span/200 

Span=0, step=RBW/100 

Min 1 Hz 

Direction Key Step Freq step 

Related to Center Freq, Span  

2.1.1.4 Freq Step 

Set the step of the center frequency. Start frequency and stop frequency vary with the step frequency 

through arrow keys. In process of using pay attention to the following points：  

◆ At a fixed step change the value of the center frequency can reach the purpose of continuous 

measurement channel switch. 

◆ There are two kinds of frequency step mode：Auto and manual. In Auto mode, the Freq step is 

1/10 of the span in Non-zero span mode or equals the RBW while in Zero span mode; in Manual 

mode; you can set the step using the numeric keys. 

Table 2-4 Frequency step 
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Parameter Explanation 

Default Full Span/10 

Range 1Hz ~ Full Span 

Unit GHz, MHz, kHz, Hz 

Knob Step Span>0, Step=Span/200 

Span=0, Step=100 

min 1 Hz 

Direction Key Step 1-2-5 sequence step 

Relation RBW, Span and related parameters 

2.1.1.5 Peak -> CF 

Execute a peak search and use the frequency of the current peak as the center frequency (CF) of the 

analyzer. The function is invalid in Zero Span mode.  

 

 

Figure 2-1 before Peak -> CF 
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Figure 2-2 after Peak -> CF 

2.1.1.6 CF -> Step 

Set the current center frequency as the CF step. At this point, the CF step will switch to “Manual” 

mode automatically. This function is usually used with channel switching. Take harmonic waveform 

measurement for example: locate a signal at the center frequency of a channel, execute CF->Step 

and then press the down direction key continuously to measure each order of harmonic in sequence 

2.1.2 Span 

Set the span of the analyzer. The change of this parameter will affect the frequency parameters and 

restart the sweep.  

2.1.2.1 Span 

Set the frequency range of the current channel. The center frequency and span are displayed at the 

low left and right sides of the grid respectively. In process of using pay attention to the following points： 

◆ The start and stop frequency vary with the span when the center frequency is constant.  

◆ In manual span mode. The span can be set down to 100Hz and up to the full span described in 

Specifications. When the span is set to the maximum, the analyzer enters full span mode.  

◆ Modifying the span in non-zero span mode may cause an automatic change in both CF step and 

RBW if they are in Auto mode. Besides, the charge of RBW may influence VBW (in Auto VBW 

mode).  

◆ Variation in the span, RBW or VBW would cause a change in the sweep time.  
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◆ In non-zero span mode, neither is “Video” trigger nor “1/△time” readout function valid.  

    

Table 2-5 Span 

Parameter Explanation 

Default Maximum bandwidth 

Range 0 Hz~ 3.2 GHz 

Unit GHz, MHz, kHz, Hz 

Knob Step Span/200, Min = 1 Hz 

Direction Key Step In 1-2-5 sequence 

Related to Start Freq, Stop Freq, Freq Step, RBW, Sweep time 

Note: 0 Hz is available only in zero span.  

2.1.2.2 Full Span 

Set the span of the analyzer to the maximum. 

2.1.2.3 Zero Span 

Set the span of the analyzer to 0Hz. Both the start and stop frequencies will equal the center frequency 

and the horizontal axis will denote time. The analyzer measures the time domain characteristics of the 

amplitude of the corresponding frequency point on the input signal. In process of using pay attention to 

the following points: 

 

The following functions are invalid in Zero span mode: Peak ->CF, Signal Track, Zoom In and Zoom 

Out. 

◆ Frequency: Peak->CF; 

◆ SPAN: Zoom In and Zoom Out;  

◆ Marker-> : M ->CF, M->CF step, M->Start Freq, M->Stop Freq, △M->CF and △M->Span;  

◆ Marker: Frequency, Period and 1/△Time(valid in Delta marker type); 

2.1.2.4 Zoom In 

Set the span to half of its current value. At this point, the signal on the screen is zoomed in to observe 

signal details.  

2.1.2.5 Zoom Out 

Set the span to twice the current value. At this point, the signal on the screen is zoomed out to gain 

more information about the signal. 
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2.1.2.6 Last Span 

Set the span to the previous span setting.  

2.1.2.7 X-Scale 

Set the scale type of X-axis to Lin or Log. 

In Log scale type, the frequency scale of X-axis is displayed in the logarithmic form. 

If the scale type of X-axis is in the logarithmic type form, the scale type will be switched into Lin when 

turning on Meas. 

2.1.3 Amplitude 

Set the amplitude parameters of the analyzer. Through modifying these parameters, signals under 

measurement can be displayed in a proper mode for easier observation and minimum error. 

2.1.3.1 Ref Level 

Set the maximum power or voltage can be currently displayed in the window. The value is displayed at 

the upper left corner of the screen grid. 

The maximum reference level available is affected by the maximum mixing level; input attenuation is 

adjusted under a constant maximum mixing level in order to fulfill the following condition: 

Ref <= ATT – PA - 20dBm 

 

Table 2-6 Ref Level 

Parameter Explanation 

Default 0 dBm 

Range -100 dBm ~ 30 dBm  

Unit dBm, dBmV, dBuV, V, W 

Knob Step In Log scale mode, step = Scale/10  

In Lin scale mode, step = 0.1 dB 

Direction Key Step In Log scale mode, step = Scale  

In Lin scale mode, step = 1 dB 

Related to Attenuator, Preamp, Ref Offset 

2.1.3.2 Attenuator 

Set the front attenuator of the RF input in order to ensure big signals (or small signals) to pass through 

the mixer with low distortion (or low noise).  

Ref <= ATT – PA - 20dBm 

Input attenuation can be set up for automatic and manual two kinds of patterns. 

◆ Automatic mode attenuation value according to the state of preamplifier and value of the current 
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reference level automatic adjustment. 

◆ Open the preamplifier; maximum input attenuation can be set to 51dB. When setting parameters 

do not meet the above formula, can adjust the reference level.  

 

Table 2-7 Attenuator 

Parameter Explanation 

Default 20 dB 

Range 0 ~ 51 dB 

Unit dB 

Knob Step 1 dB 

Direction Key Step 5 dB 

Related to Preamp, Ref level 

2.1.3.3 RF Preamp 

Turn on or off the preamplifier located at the front of the RF signal path. When signal under 

measurement is small, turning on the preamplifier can reduce the displayed noise level; there for, you 

can distinguish small signals from the noise. 

The corresponding icon “PA” will appear at the left side of the screen when the preamplifier is turned 

on.  

2.1.3.4 Units 

Set the unit of the Y-axis to dBm, dBmV, dBuV, Volts (RMS) and Watts. The default is dBm。 

The conversion relationships between units are as follows. 

dBm = 10lg(
Volts2

R
×

1

1mW
) 

dBμV = 20lg (
Volts

1μV
) 

dBmV = 20lg (
Volts

1mV
) 

Watts =
Volts2

R
 

Wherein, R denotes the reference resistance. Default value is 50Ω, setting by “Correction -> RF input”. 

The “75 Ω” resistance is just a numeric value, not a real resistance. 

2.1.3.5 Scale 

Set the logarithmic units per vertical grid division on the display. This function is only available when the 
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scale type is set to “log”. In process of using pay attention to the following points: 

◆ By changing the scale, the amplitude range available is adjusted。  

◆ The Minimum range: reference level –10 × current scale value;  

◆ The Maximum range: the reference level. 

 

Table 2-8 Scale 

Parameter Explanation 

Default 10 dB 

Range 1 dB ~ 20 dB 

Unit dB 

Knob Step 1 dB  

Direction Key Step 1-2-5 sequence 

Related to Scale Type 

2.1.3.6 Scale Type 

Set the scale type of Y-axis to Lin or Log. The default is Log. 

◆ In Lin mode, Scale value cannot be changed. Display area for reference level of 0%. In process of 

using pay attention to the following points: 

◆ In Log scale type, the Y-axis denotes the logarithmic coordinate; the value shown at the top of the 

grid is the reference level and each grid represents the scale value. The unit of Y-axis will 

automatically switch to the default unit (dBm) in Log scale type is changed from Lin to Log.  

◆ In Lin scale type, the Y-axis denotes the liner coordinate; the values shown at the top of the grid 

and the bottom of the grid are the reference level and the scale setting function is invalid. The unit 

of Y-axis will automatically switch to the default unit (Volts) in Lin scale type when the scale type is 

charged from Log to Lin. 

2.1.3.7 Ref Offset  

Assign an offset to the reference level to compensate for gains or losses generated between the device 

under measurement and the analyzer. 

The change of this value changes both the reference level readout and the amplitude readout of the 

marker; but does not impact the position of the curve on the screen.   

Table 2-9 Ref Offset 

Parameter Explanation 

Default 0dB 

Range -100dB ~ 100dB 

Unit dB 

Knob Step 1dB 

Direction Key Step 10dB 
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2.1.3.8 Correction 

Correct the amplitude in order to compensate for the gain or loss from external devices such as 

Antenna and Cable. When using this function, you can view the correction data table and save or load 

the current correction data. When amplitude correction is turn on, both the trace and related 

measurement results will be corrected. 

 

1. RF Input 

Set the input impedance for voltage-to-power conversions. The default is 50Ω. To measure a 75Ω 

device, you should use a 75Ω to 50Ω adapter to connect the analyzer with the system under test and 

then set the input impedance to 75Ω. 

 

2. Apply Correction 

Enable or disable amplitude correction and the default are Off. The spectrum analyzer provides four 

correction factors and you can edit them separately. 

 

3. Edit Correction Factor 

Table 2-10 Edit Correction table  

Function Explanation 

Correction Select the correction factor on or off. 

Add Point Add a point into correction table. 

Point Num  Select a point to edit by point num. 

Frequency Edit the frequency value for the current selected point. 

Amplitude Edit the amplitude value for the current selected point. 

Del Point Delete the selected correction point. 

Del All Clear all data of the correction table. 

Save/Load Save or load correction data. You can save the current correction data 

into or load correction data from a .COR file. 

2.1.4 Auto Tune 

Search for signals automatically throughout the full frequency range; adjust the frequency and 

amplitude for optimum display effect of the signal to realize one-key signal search and auto setting of 

parameters. 

◆ In the process of auto search, The “Auto Tune” is shown in the status bar on the screen until the 

search is finished. 

◆ Some parameters such as the reference level, scale, input attenuation and maximum mixing level 

may be changed during the auto search.  
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Figure 2-3 before Auto Tune 

 

 

Figure 2-4 after Auto Tune 
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2.2 Sweep and Functions 

2.2.1 BW 

Set the RBW (Resolution Bandwidth), VBW (Video Bandwidth), average type parameters of the 

analyzer and filter shape. 

2.2.1.1 Resolution Bandwidth 

Set the resolution bandwidth in order to distinguish between signals which are close in frequency. 

◆ Reducing RBW will increase the frequency resolution, but will increase the sweep time (Sweep 

Time is affected by a combination of RBW and VBW when it is in Auto mode).  

◆ RBW varies with the span (non-zero span) in Auto RBW mode. 

 

Table 2-11 RBW 

Parameter Explanation 

Default 1MHz 

Range 10Hz ~ 1MHz 

Unit MHz, kHz, Hz 

Knob Step in 1, 3, 10 sequence 

Direction Key Step in 1, 3, 10 sequence 

Relation Span, RBW, VBW, Sweep Time 

2.2.1.2 Video Bandwidth 

Set the desired video bandwidth in order to filter out the noise outside the video band. 

◆ Reducing the VBW will smooth the spectrum line to highlight small signals from noise, but will 

increase the sweep time (Sweep Time is affected by a combination of RBW and VBW when it is in 

Auto mode). 

◆ VBW varies with RBW when it is set to Auto. While in Manual mode, VBW is not affected by RBW. 

 

Table 2-12 VBW 

Parameter  Explanation 

Default  1MHz 

Range  1Hz ~ 3MHz 

Unit  MHz, kHz, Hz 

Knob Step  in 1, 3, 10 sequence 

Direction Key Step  in 1, 3, 10 sequence 

Relation  RBW, V/R Ratio, Sweep Time 
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2.2.1.3 V/R Ratio 

Set the ratio of VBW to RBW. This value is different while measuring different kinds of signals:  

◆ Sine signal: use 1 to 3 (for faster sweeps) 

◆ Pulse signal: use 10 (to reduce the influence on the amplitude of transient signals) 

◆ Noise signal: generally use 0.1 (to obtain the average of noises) 

 

Table 2-13 V/R Ratio 

Parameter  Explanation 

Default  1 

Range  0.001 ~ 1000 

Unit  N/A 

Knob Step  in 1, 3, 10 sequence 

Direction Key Step  in 1, 3, 10 sequence  

Relation  RBW,VBW 

2.2.1.4 Average Type  

Choose one of the following averaging types: log power (video), power (RMS), or voltage averaging. 

When trace average is on, the average type is shown on the left side of the display. 

 

1. Log Power 

Select the logarithmic (decibel) scale for all filtering and averaging processes. This scale is "Video" 

because it is the most common display and analysis scale for the video signal within a spectrum 

analyzer. This scale is excellent for finding CW signals near noise. 

 

2. Power Average 

In this average type, all filtering and averaging processes work on the power (the square of the 

magnitude) of the signal, instead of its log or envelope voltage. This scale is best for measuring the true 

time power of complex signals. 

 

3. Voltage Average 

In this Average type, all filtering and averaging processes work on the voltage of the envelope of the 

signal. This scale is good for observing rise and fall behavior of AM or pulse-modulated signals such as 

radar and TDMA transmitters. 

2.2.1.5 Filter 

Set the RBW filter type. The analyzer supports two kinds of RBW filters: “Gauss” (-3 dB bandwidth) and 

“EMI” (-6 dB bandwidth). 

When “EMI” is selected, resolution bandwidth can be 200 Hz, 9 kHz or 120 kHz only. 

“Quasi-Peak” detector is available only in “EMI” filter. 
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2.2.2 Trace 

The sweep signal is displayed as a trace on the screen. 

2.2.2.1 Select Trace  

Spectrum Analyzer allows for up to four traces to be displayed at the same time. Each trace has its own 

color (Trace 1 - Yellow, Trace 2 - Purple, Trace 3 - Light blue and Trace 4 - Green). All traces can be set 

parameter independently.  

As a default, spectrum analyzer will choose Trace A and set the type of the trace as Clear Write  

2.2.2.2 Trace Type 

Set the type of the current trace or disable it.  

The system calculates the sampled data using a specific operation method according to the trace type 

selected and displays the result. Trace types include Clear Write, Max Hold, Min Hold, View, Average 

and Bank.  

The corresponding icon of the trace type will be displayed in the status bar at the left of the screen. 

Take Trace 1,2,3,4 as an example and the icons are as shown in the figure below. 

 

Figure 2-5 Trace Type 

 

1. Clear Write 

Erases any data previously stored in the selected trace, and display the data sampled in real-time of 

each point on the trace. 

 

http://cn.bing.com/dict/clientsearch?mkt=zh-CN&setLang=zh&form=BDVEHC&ClientVer=BDDTV3.5.0.4311&q=%E9%A2%91%E8%B0%B1%E4%BB%AA
http://cn.bing.com/dict/clientsearch?mkt=zh-CN&setLang=zh&form=BDVEHC&ClientVer=BDDTV3.5.0.4311&q=%E9%A2%91%E8%B0%B1%E4%BB%AA
http://cn.bing.com/dict/clientsearch?mkt=zh-CN&setLang=zh&form=BDVEHC&ClientVer=BDDTV3.5.0.4311&q=%E9%A2%91%E8%B0%B1%E4%BB%AA
http://cn.bing.com/dict/clientsearch?mkt=zh-CN&setLang=zh&form=BDVEHC&ClientVer=BDDTV3.5.0.4311&q=%E9%A2%91%E8%B0%B1%E4%BB%AA
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2. Max Hold 

Retains the maximum level for each trace point of the selected trace. Updates the data if a new 

maximum level is detected in successive sweeps.  

 

3. Min Hold 

Display the minimum from multiple sweeps for each point of the trace and update the data if a new 

minimum is generated in successive sweeps. 

 

4. View 

Holds and displays the amplitude data of the selected trace. The trace data is not updated as the 

analyzer sweeps. 

 

5. Bank 

Disable the trace display and all measurements of this trace. 

2.2.2.3 Average Times 

Set the number of averages of the selected trace. More averages can reduce the noise and the 

influence of other random signals; thus highlighting the stable signal characteristics. The larger the 

number of averages is, the smoother the trace will be. 

 

Table 2-14 Average Times 

Parameter  Explanation 

Default  100 

Range  1 ~ 999 

Unit  N/A 

Knob Step  1 

Direction Key Step  5 

2.2.2.4 Math  

Set the computational method of the math trace. 

2.2.2.5 Variable X, Y 

Variable X, Y can choose trace A, B, C. 

2.2.2.6 Output Z 

The result Z will show on screen in trace A, B, C as you choose. 
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2.2.2.7 Calculation Type 

Spectrum Analyzer provides the calculation types as shown below: 

Power : X-Y+Offset 

Power : X+Y+Offset 

Log : X+Offset 

Log : X-Y+Ref 

2.2.3 Detect 

The analyzer displays the sweep signal on the screen in the form of trace. For each trace point, the 

analyzer always captures all the data within a specific time interval and processes (Peak, Average, etc.) 

the capture data using the detector currently selected, then display the processed data (one point) on 

the screen. 

◆ Select an appropriate detector type according to the actual application in order to ensure the 

accuracy of the measurement.  

◆ The available types are Pos Peak, Neg Peak, Sample, Normal, Average and Quasi Peak. The 

default is Pos peak. 

 

1. Positive Peak 

For each trace point, Positive Peak detector displays the maximum value of data sampled within the 

corresponding time interval. 

 

2. Negative Peak 

For each trace point, Negative Peak detector displays the minimum value of data sampled within the 

corresponding time interval. 

 

3. Sample 

For each trace point, Sample detector displays the transient level corresponding to the central time 

point of the corresponding time interval. This detector type is applicable to noise or noise-like signal. 

 

4. Normal 

Normal detector (also called rosenfell detector) displays the maximum value and the minimum value of 

the sample data segment in turn; namely for an odd-numbered data point, the maximum value is 

displayed; for an even-numbered data point, the minimum value is displayed. In this way, the amplitude 

variation range of the signal is clearly shown. 

 

5. Average 

For each trace point, Average detector displays the average value of data sampled within the 

corresponding time interval. 

 

6. Quasi Peak 

Quasi-Peak detector, which is a weighted form of peak detector, is used for EMC pulse testing ruled by 

CISPR. For single frequency point, the detector detects the peaks within QPD dwell time. The peaks 

http://cn.bing.com/dict/clientsearch?mkt=zh-CN&setLang=zh&form=BDVEHC&ClientVer=BDDTV3.5.0.4311&q=%E9%A2%91%E8%B0%B1%E5%88%86%E6%9E%90%E4%BB%AA
http://cn.bing.com/dict/clientsearch?mkt=zh-CN&setLang=zh&form=BDVEHC&ClientVer=BDDTV3.5.0.4311&q=%E9%A2%91%E8%B0%B1%E5%88%86%E6%9E%90%E4%BB%AA
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detected are weighted using circuit with specified charge and discharge structures as well as the 

display time constant specified in the CISPR 16 standards.  

The measurement time for QPD is far longer than Peak Detector. 

2.2.4 Sweep 

Set parameters about the Sweep functions, including sweep time, sweep rule, sweep mode, number of 

sweep, etc. 

2.2.4.1 Sweep Time 

Set the time needed for the spectrum analyzer to finish a sweep within the span range. The sweep time 

can be set in “Auto” or “Manual” mode and the default is “Auto”. 

◆ In non-zero span, the analyzer selects the shortest sweep time on the basis of the current RBW 

and VBW settings if Auto is selected. 

◆ Decreasing the sweep time would speed the measurement. However, an error may be caused if 

the specified sweep time is less than the minimum sweep time in Auto coupling; at this point, 

“UNCAL” is shown in the status bar on the screen  

 

Table 2-15 Sweep Time 

Parameter  Explanation 

Default  N/A 

Range  900 us ~ 3 ks（Quasi Peak：900 us ~ 30 ks） 

Unit  ks, s, ms, us 

Knob Step  Sweep time/100, min =1 ms 

Direction Key Step   in 1,3 sequence 

2.2.4.2 Sweep Rule 

The analyzer provides two sweep time rules to meet the different sweep time requirements: 

Speed: Activates the default fast sweep time rule. 

Accuracy: Activates the normal sweep time rule to ensure the measurement accuracy. Speed sweep 

time rule provides a fast measurement function that decreases the sweep time. Using Fast Sweep will 

decrease the measurement accuracy. 

2.2.4.3 Sweep  

Set sweep mode in single or continuous, the default is continuous. The corresponding icon of the 

sweep will be displayed in the status bar at the left of the screen. 

 

1. Single 

Set the sweep mode to “Single”. The number on the parameter icon denotes the current sweep 

number. 



SIGLENT 

SSA3000X User Manual 32 

 

2. Numbers 

Set the number of sweeps for a single sweep. In single sweep mode, the system executes the specified 

number of sweeps and the number shown on the icon in the status bar at the left of the screen varies 

with the process of the sweep. 

 

3. Continue 

Set the sweep mode to “Continue”. The character Cont on the parameter icon denotes the 

analyzer is sweeping continuously. 

◆ If the instrument is in single sweep mode and no measurement function is enabled, press this key 

and the system will enter continuous sweep mode and sweep continuously if the trigger conditions 

are satisfied.  

◆ If the instrument is in single sweep mode and a measurement function is on, press this key and the 

system will enter continuous sweep mode and measure continuously if the trigger conditions are 

satisfied. 

◆ In continuous sweep mode, the system will send a trigger initialization signal automatically and 

enter the trigger condition judgment directly after each sweep. 

 

Table 2-16 Sweep Times 

Parameter  Explanation 

Default  1 

Range  1 ~ 9999 

Unit  N/A 

Knob Step  1 

Direction Key Step  1 

2.2.4.4 Sweep Mode 

Sweep mode includes auto, sweep and FFT. 

 

1. Auto 

When the sweep mode is auto, the analyzer selects the sweep mode automatically between 

Sweep and FFT Mode in the shortest time. 

 

2. Sweep 

Work in point-by-point scanning. The Sweep mode is only available when RBW is in 30 Hz – 1 MHz 

 

3. FFT 

Work in FFT scanning. The FFT mode is only available when RBW is in 1 Hz - 30 kHz. 

 

When TG is on, the sweep mode is forced to Sweep. 



                                                                             SIGLENT 

SSA3000X User Manual 33  

2.2.4.5 QPD Dwell Time 

Dwell time is the measurement time at a single frequency. QPD detector gets its weighted envelope 

response during dwell time. The longer dwell time is, the more sufficiently QPD detector responses to a 

single frequency, the more accuracy the QPD detector envelope is. 

 

Table 2-17 QPD Dwell Times 

Parameter  Explanation 

Default  50 ms 

Range  0 s ~ 10 s 

Unit  ks, s, ms, us 

Knob Step  N/A 

Direction Key Step  N/A 

 

2.2.5 Trigger 

The trigger type can be Free Run, Video or External.  

 

1. Free Run 

The trigger conditions are satisfied at any time and the analyzer generates trigger signals continuously.  

  

2. Video Trigger 

A trigger signal will be generated when the system detects a video signal of which the voltage exceeds 

the specified video trigger level. 

Set the trigger level in video trigger. At this point, the trigger level line (Trig Line) and value are 

displayed on the screen. 

 

 

Table 2-18 Trigger Setup 

Parameter  Explanation 

Default  0 dBm 

Range  -300 dBm ~ 50 dBm 

Unit  dBm 

Knob Step  1 dB 

Direction Key Step  10 dB 

 

3. External 

In this mode, an external signal (TTL signal) is input from the [TRIGGER IN] connector at the rear panel 

and trigger signals are generated when this signal fulfills the specified trigger edge condition. 

 

Set the trigger edge in external trigger to the rising (Pos) or falling (Neg) edge of the pulse.  
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2.2.6 Limit 

The analyzer supports Pass/Fail test function. In this function, the measured curve is compared with 

the pre-edited curve. If the related rules are met, the result is “Pass”; or else is “Fail”. 

2.2.6.1 Limit1 

Select enable or disable limit1. 

2.2.6.2 Limit1 Edit 

Edit the properties of the limit1 lines. 

 

Table 2-19 Limit1 Edit Menu 

Function  Explanation 

Type  Select the desired limit line (upper or lower) for editing 

Mode Select the line or point for editing. Set the number of the point to be edited if you selected 

the point type. The range from 1 to 100  

Add point Add a new point for editing. 

X-axis Edit the X-axis value (frequency or time) of the current point. If the X-axis unit is 

frequency and the Ref Freq is enabled, edit the frequency difference between the 

frequency of the current point and the center frequency. 

Amplitude Edit the amplitude of the current point or line. If the Ref AMPT is enabled, edit the 

amplitude difference between the amplitude of the current point and the reference level. 

Del Point Delete the point you are editing. 

Del All Delete all point. 

Save/Recall Save or load the limit file. 

2.2.6.3 Limit2 

Select enable or disable limit2. 

2.2.6.4 Limit2 Edit 

Edit the properties of the limit2 lines. 

 

Table 2-20 Limit2 Edit Menu 

Function  Explanation 

Type  Select the desired limit line (upper or lower) for editing 

Mode Select the line or point for editing. Set the number of the point to be edited if you selected 

the point type. The range from 1 to 100  
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Add point Add a new point for editing. 

X-axis Edit the X-axis value (frequency or time) of the current point. If the X-axis unit is 

frequency and the Ref Freq is enabled, edit the frequency difference between the 

frequency of the current point and the center frequency. 

Amplitude Edit the amplitude of the current point or line. If the Ref AMPT is enabled, edit the 

amplitude difference between the amplitude of the current point and the reference level. 

Del Point Delete the point you are editing. 

Del All Delete all point. 

Save/Recall Save or load the limit file. 

2.2.6.5 Test 

Enable or disable the limit test function. 

2.2.6.6 Setup 

1. Fail to stop 

Select whether the instrument will continue or stop operation when a failure occurs. 

 

2. Buzzer 

Turn on or off the buzzer. When the buzzer is on, it beeps when a failure occurs.  

 

3. X Axis 

Set the X-axis unit to frequency or time unit.  

Note that all the points of the current limit line will be deleted when the X-axis unit changes.  

2.2.7 TG（Tracking Generator） 

Set the parameters related to the tracking generator. 

2.2.7.1 TG 

When the TG is enabled, a signal with the same frequency of the current sweep signal will be output 

from the [TG SOURCE] connector at the front panel. The power of the signal could be set through the 

menu.  

2.2.7.2 TG Level 

Set the output power of the signal of the tracking generator. 

 

Table 2-21 TG Level 

Parameter  Explanation 
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Default  0 dB 

Range  -20 dBm ~ 0 dBm 

Unit  dBm 

Knob Step  1 dB 

Direction Key Step  10 dB 

2.2.7.3 TG Level Offset  

Assign a certain offset to the output power of the TG when gains or losses occur between the TG 

output and external device in order to display the actual power value. 

◆ This parameter only changes the readout of the TG output power, rather than the actual value.  

◆ The offset could be either a positive (gain in the external output) or a negative (loss in the external 

output).  

 

Table 2-22 TG Level Offset 

Parameter  Explanation 

Default  0 dB 

Range  -200 dB ~ 200 dB 

Unit  dB 

Knob Step  1 dB 

Direction Key Step  10 dB 

2.2.7.4 Normalize 

Normalization can eliminate the error of TG Level. Before using this function, connect the [TG 

SOURCE] output terminal of the TG with the [RF INPUT] input terminal of the analyzer.  

When enabled, the reference trace will be stored automatically after the current sweep finishes if no 

reference trace is stored before. During the reference trace storage, the corresponding prompt 

message is displayed.  

When normalization is enabled, the corresponding value of the reference trace will be subtracted from 

the trace data after every sweep. 

 

Default 

reference plane

Normalized 

reference plane
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Figure 2-6 Normalization 

2.2.7.5 Norm Ref Level 

Adjust the vertical position of the trace on the screen by adjusting the reference level when 

normalization is enabled.  

Different from the Ref Level function in the AMPT menu, this parameter has no influence on the 

reference level of the analyzer.  

 

Table 2-23 Reference level under normalization  

Parameter  Explanation 

Default  0 dB 

Range  -200 dB ~ 200 dB 

Unit  dB 

Knob Step  1 dB 

Direction Key Step  10 dB 

2.2.7.6 Norm Ref Pos 

Adjust the vertical position of the normalization reference level on the screen by adjusting the reference 

position when normalization is enabled. 

The function of this menu is similar to that of Norm Ref Level. When it is set to 0%, the normalization 

reference level is displayed at the bottom of the screen grid and at the top when it is set to 100%.  

 

Table 2-24 TG reference position under normalization 

Parameter  Explanation 

Default  100% 

Range  0 ~ 100% 

Unit  100% 

Knob Step  1% 

Direction Key Step  10% 

2.2.7.7 Ref Trace 

Set whether to display the reference trace or not. If “View” is selected, the reference trace saved (Trace 

D) will be shown in “View” type.  

Note: When normalization is enabled, the unit of Y-axis is “dB” and will not be influenced by the 

definition in AMPT->Units. At this point, “(dB)” is displayed under the Y-axis scale in the user interface. 

2.2.8 Demod 

Press Demod at the front panel to enter the demodulation setting menu. Both AM and FM 
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demodulations are available in this device. 

2.2.8.1 Demod (AM/FM) 

Set the demodulation type to AM or FM; or disable the demodulation function. The default is off.  

◆ The system will enable a marker automatically, place it at the center frequency and perform AM (or 

FM) demodulation on this frequency point after you enable AM (or FM) demodulation.  

◆ Analyzer provides earphone jack and the demodulated signal can be output in audio frequency 

(AF) mode through the earphone. The frequency and intensity of AF denotes the frequency and 

amplitude of the signal respectively.  

2.2.8.2 Earphone 

Set the status of the earphone. When it is on, the demodulated signal can be heard through the 

earphone during the demodulation. By default, it is off.  

2.2.8.3 Volume 

Set the volume of the earphone.  

 

 

Table 2-25 Volume 

Parameter  Explanation 

Default  6 

Range  0 ~ 10 

Unit  N/A 

Knob Step  1 

Direction Key Step  1 

2.2.8.4 Demod Time 

Set the time for the analyzer to complete a signal demodulation after each sweep. If Earphone is set to 

“On”, you will hear the demodulated signal through the earphone during the demodulation. A longer 

demod dwell time would be better to demodulate audio signal. 

 

Table 2-26 Demod time 

Parameter  Explanation 

Default  5 s 

Range  5 ms ~ 1000 s 

Unit  ks, s, ms 

Knob Step  0 ms ~ 100 ms, step=1 ms；  

100 ms ~ 1 s, step =10 ms；  
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1 s ~ 10 s, step =100 ms；  

10 s ~ 100 s, step =1 s；  

100 s ~ 1000 s, step =10 s 

Direction Key Step  1-2-5 step 
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2.3 Marker 

2.3.1 Marker 

The marker appears as a rhombic sign (as shown below) for identifying the point on the trace. You can 

easily read the amplitude, frequency and sweep time of the marked point on the trace.  

◆ The analyzer allows for up to four pairs of markers to be displayed at one time, but only one pair or 

a single marker is active every time.  

◆ You can use the numeric keys, knob or direction keys to modify the desired frequency or time as 

well as view the readouts of different points on the trace.  

 

 

Figure 2-7 Marker 

2.3.1.1 Select Marker 

Select one of the four markers and the default is Marker1.  

When a marker is selected, you can set its type, trace to be marked, readout type and other related 

parameters. The enabled marker will appear on the trace selected through the Select Trace option and 

the readouts of this marker are also displayed in the active function area and at the upper right corner 

of the screen. 
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Table 2-27 Marker parameters  

Parameter  Explanation 

Default  Center Frequency 

Range  0 ~ Full Span 

Unit  Readout = Frequency , units available are GHz, MHz, kHz, Hz 

Readout = Time, units available are s, ms, us, ns, ps  

Knob Step  Readout = Frequency (or Period), Step = Span/(Sweep Points - 1)  

Direction Key Step   Readout = Frequency (or Period), Step = Span/10  

2.3.1.2 Select Trace  

Select the trace to be marked by the current marker from A, B, C, D. 

2.3.1.3 Normal 

One of the marker types. It is used to measure the X (Frequency or Time) and Y (Amplitude) values of a 

certain point on the trace. When selected, a marker with the number of the current marker (such as “1”) 

appears on the trace. 

◆ If no active marker exists currently, a marker will be enabled automatically at the center frequency 

of the current trace.  

◆ You can use the numeric keys, knob or direction keys to move the marker. The readouts of the 

marker will be displayed at the upper right corner of the screen. 

◆ The readout resolution of the X-axis (frequency or time) is related to the span. For higher readout 

resolution, reduce the span.  

2.3.1.4 Delta 

One of the marker types. It is used to measure the delta values of X (Frequency or Time) and Y 

(Amplitude) between the reference point and a certain point on the trace. When selected, a pair of 

markers appears on the trace: Reference Marker (marked by a combination of the marker number and 

letter “r”, such as “1r”) and the Delta Marker (marked by the marker number, such as “1”). 

◆ A reference marker will be activated at the position of the current marker if an active marker 

currently exists; or else both the reference marker and delta marker will be simultaneously 

activated at the center frequency.  

◆ The location of the reference marker is always fixed (both on the X-axis and the Y-axis); while the 

Delta Marker is active. You can use the numeric keys, knob or direction keys to change the 

location of the Delta Marker.  

◆ The frequency (or time) delta and amplitude delta between the two markers are displayed at the 

upper right corner of the screen.  

◆ There are two methods for defining a point as the reference point:   

a) Open a “Normal” marker and locate it onto a point. Then, switch the marker type to “Delta”; at 

this time, this point is the reference point. You can modify the location of the delta point to achieve 

delta measurement.  
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b) Open a “Delta” marker and locate it onto a point. Then, reselect the Delta menu to locate the 

reference marker onto this point. You can modify the location of the delta point to achieve delta 

measurement.  

 

The application of “Delta” marker  

Measure the signal-noise ratio of single spectrum signal: Place the reference and delta Markers onto 

the signal and noise respectively, the amplitude in the measurement result is the signal-noise ratio. 

2.3.1.5 Delta Pair 

One of the marker types. When selected, a pair of markers will appear on the trace: Reference Marker 

(marked by a combination of the marker number and letter “R”, such as “1R”) and the Delta Marker 

(marked by the marker number, such as “1”). 

◆ You can use the numeric keys, knob or direction keys to set the locations of the reference marker 

(selecting “Ref”), the delta marker (selecting “Delta”), the span of marker pair(selecting “Span”) 

and the center of marker pair(selecting “Center”) respectively.  

◆ This is different from the Delta type marker in that you can modify both the reference (selecting 

“Ref”) and delta (selecting “Delta”) points or modify both them at the same time (selecting “Span” 

or “Center”). Additionally, both the X and Y values of the reference marker are stable for “Delta” 

marker during the sweep; but the Y value of the reference marker updates along with the sweep 

for “Delta Pair” marker  

◆ If “Span” is selected, setting the “Span Pair” will keep the center position of the two markers 

unchanged and move them towards the two sides (value increases) or the middle (value 

decreases).  

◆ If “Center” is selected, setting the “Span Pair” will keep the relative distance between the two 

markers unchanged and move their center position left (value decreases) or right (value 

increases).  

2.3.1.6 Relative To 

Relative to be used to measure the delta values of X (Frequency or Time) and Y (Amplitude) between 

two markers which mark on different traces. 

2.3.1.7 Off 

Turn off the marker currently selected. The marker information displayed on the screen and functions 

based on the marker will also be turned off. 

2.3.1.8 Marker Table 

Enable or disable the Marker Table.  

Display all the markers enabled on the lower portion of the screen, including marker number, trace 

number, marker readout type, X-axis readout and amplitude. Through this table you can view the 
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measurement values of multiple points. The table allows for up to eight markers to be displayed at one 

time.  

 

Figure 2-8 Marker table 

 

2.3.2 Marker -> 

1. M->CF 

Set the center frequency of the analyzer to the frequency of the current marker.  

◆ If Normal marker is selected, the center frequency will be set to the frequency of the current 

marker.  

◆ If Delta or Delta Pair marker is selected, the center frequency will be set to the frequency of the 

Delta Marker.  

◆ The function is invalid in Zero span mode.  

 

2. M -> CF Step 

Set the center frequency step of the analyzer to the frequency of the current marker.  

◆ If Normal marker is selected, the center frequency step will be set to the frequency of the current 

marker.  

◆ If Delta or Delta Pair marker is selected, the center frequency step will be set to the frequency of 

the Delta Marker.  

◆ The function is invalid in Zero span mode. 

 

3. M -> Start Freq 

Set the start frequency of the analyzer to the frequency of the current marker.  
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◆ If Normal marker is selected, the start frequency will be set to the frequency of the current marker.  

◆ If Delta or Delta Pair marker is selected, the start frequency will be set to the frequency of the 

Delta Marker.  

◆ The function is invalid in Zero span mode. 

 

4. M -> Stop Freq 

Set the stop frequency of the analyzer to the frequency of the current marker.  

◆ If Normal marker is selected, the stop frequency will be set to the frequency of the current marker.  

◆ If Delta or Delta Pair marker is selected, the stop frequency will be set to the frequency of the 

Delta Marker.  

◆ The function is invalid in Zero span mode. 

 

5. M ->Ref Level 

Set the reference level of the analyzer to the amplitude of the current marker. 

◆ If Normal marker is selected, the reference level will be set to the amplitude of the current marker.  

◆ If Delta or Delta Pair marker is selected, the reference level will be set to the amplitude of the 

Delta Marker.  

 

6. ΔM->Span 

Set the span of the analyzer to the frequency difference between the two markers in Delta, or Delta 

Pair marker type.  

◆ If Normal marker is selected, this function is invalid.  

◆ The function is invalid in Zero span mode. 

 

7. ΔM->CF 

Set the center frequency of the analyzer to the frequency difference between the two markers in Delta, 

or Delta Pair, marker type. 

◆ If Normal marker is selected, this function is invalid.  

◆ The function is invalid in Zero span mode. 

2.3.3 Marker Fn 

Special marker functions including Noise Marker, N dB BW and Freq Counter. 

2.3.3.1 Select Marker 

Select one of the four markers (1, 2, 3, and 4) and the default is Marker1. 

2.3.3.2 Noise Marker 

Execute the Noise marker function for the selected marker and read the noise power spectral density. 
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◆ If the current marker is “Off” in the Marker menu, pressing Noise Marker will first set it to Normal 

type automatically; then measure the average noise level at the marked point and normalize this 

value to 1 Hz bandwidth. During this process, certain compensation is always made on the basis 

of the detection and trace types. The measurement will be more precise if RMS Avg or Sample 

detection type is used.  

◆ This function can be used for measuring the C/N ratio. 

2.3.3.3 N dB BW 

Enable the N dB BW measurement or set the value of N dB. The N dB BW denotes the frequency 

difference between two points that are located on both sides of the current marker and with N dB fall 

(N<0) or rise (N>0) in amplitude as shown in the figure on the next page.  

 

 

Figure 2-9 N dB BW 

When the measurement starts, the analyzer will search for the two points which are located at both 

sides of the current point with N dB fall or rise in amplitude and display the frequency difference 

between the two points in the active function area. "----" would be displayed if the search fails.  

 

Table 2-28 N dB Noise 

Parameter  Explanation 

Default  -3 dB 

Range  -100 dB ~ 100 dB 

Unit  dB 

Knob Step  0.1 dB 
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Direction Key Step  1 dB 

2.3.3.4 Freq Counter 

Turn on or off the frequency counter. The frequency readout is accuracy is up to 0.01 Hz.  

◆ The function is invalid when selecting marker 2, 3, 4. 

◆ If marker 1 is selected but no active, turning on the frequency counter will open marker 1 Normal 

marker automatically.  

◆ The frequency counter measures the frequency near the center frequency in Zero span mode.  

2.3.3.5 Off 

Turn off the noise marker enabled, N dB BW measurement or Frequency Counter, but not the marker 

itself. 

2.3.3.6 Read Out 

Select a desired readout type of the X-axis for the marker and different markers can use different 

readout types. This setting will change the readout type and affect the marker readings in the active 

function area and at the upper right corner of the screen, but will not change the actual value. 

 

1. Frequency  

In this type, Normal marker shows the absolute frequency; while Delta marker and Delta Pair marker 

show the frequency difference between the delta marker and reference marker. The default readout 

mode in non-zero span mode is “Frequency”. 

Note: This type is invalid in Zero span mode. 

 

2. Period 

In this type, Normal marker shows the reciprocal of frequency; while Delta marker and Delta Pair 

marker show the reciprocal of frequency difference. When the frequency difference is zero, the 

reciprocal is infinite and 100 Ts is displayed.  

Note: This type is invalid in Zero span mode. 

3. Δ Time 

In this type, Normal marker shows the time difference between the marker and the start of the sweep; 

while Delta marker and Delta Pair marker show the sweep time difference between the delta marker 

and reference marker. 

The default readout mode in Zero span mode is Δ Time.  

2.3.4 Peak 

Open the peak search setting menu and execute peak search. 
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2.3.4.1 Peak -> CF 

Execute peak search and set the center frequency of the analyzer to the frequency of the peak. 

2.3.4.2 Next Peak 

Search for and mark the peak whose amplitude is closest to that of the current peak and which meets 

the peak search condition. 

2.3.4.3 Next Left Peak 

Search for and mark the nearest peak which is located at the left side of the current peak and meets the 

peak search condition. 

2.3.4.4 Next Right Peak 

Search for and mark the nearest peak which is located at the right side of the current peak and meets 

the peak search condition. 

2.3.4.5 Peak Peak 

Execute peak search and minimum search at the same time and mark the results with delta pair 

markers. Wherein, the result of peak search is marked with the delta marker and the result of minimum 

search is marked with the reference marker.  

2.3.4.6 Count Peak 

Enable or disable continuous peak search and the default are Off. When enabled, the system will 

always execute a peak search automatically after each sweep in order to track the signal under 

measurement. 

2.3.4.7 Peak Table 

Open the peak table (in the lower window) which lists the peaks (with frequency and amplitude) that 

meet the peak search condition. Up to 16 peaks can be displayed in the table. 

2.3.4.8 Search Comfit 

Define the conditions of peak search for various peak searches. A real peak should meet the 

requirements of both the “Peak Excursion” and “Peak Threshold”. 
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1. Peak Threshold  

Assign a minimum for the peak amplitude. Peaks whose amplitudes are greater than the specified peak 

threshold are treated as real peaks. 

 

Table 2-29 Peak Threshold 

Parameter  Explanation 

Default  -160 dBm 

Range  -200 dBm ~ 200 dBm 

Unit  dBm 

Knob Step  1 dB 

Direction Key Step  5 dB 

 

2. Peak Excursion 

Set the excursion between the peak and the minimum amplitude on both sides of it. Peaks whose 

excursions are beyond the specified excursion are treated as real peaks. 

 

Table 2-30 Peak Excursion 

Parameter  Explanation 

Default  15 dB 

Range  0 dB ~ 200 dB 

Unit  dB 

Knob Step  1 dB 

Direction Key Step  5 dB 

 

3. Peak Type 

Set the peak search condition. The available options are Maximum and Minimum 
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2.4 Measurement 

2.4.1 Meas 

Provide measurement function, the screen will be divided into two parts, the above part is measure 

screen, displaying trace, the other part is used to display result of a measurement.  

2.4.1.1 Channel Power 

Measure the power and power density within the specified channel bandwidth. When this function is 

enabled, the span and resolution bandwidth are automatically adjusted to smaller values. Select 

Channel Power and press Meas Setup to set the corresponding parameters.  

2.4.1.2 ACPR 

Measure the powers of the main channel and adjacent channels as well as the power difference 

between the main channel and each of the adjacent channels. When this function is enabled, the span 

and resolution bandwidth of the analyzer are adjusted to smaller values automatically.  

Select ACPR and press Meas Setup to set the corresponding parameters.  

2.4.1.3 Occupied BW 

Integrate the power within the whole span and calculate the bandwidth occupied by this power 

according to the specified power ratio. The OBW function also indicates the difference (namely 

“Transmit Freq Error”) between the center frequency of the channel under measurement and the center 

frequency of the analyzer. Select Occupied BW and press Meas Setup to set the corresponding 

parameters.  

2.4.1.4 T-Power 

The system enters zero span mode and calculates the power within the time domain. The types of 

powers available include Peak, Average and RMS. Select T-Power and press Meas Setup to set the 

corresponding parameters.  

2.4.1.5 TOI 

Automatic measurement of IP3 (Third order Intercept Point), including the power of fundamental wave 

and the Third order in the power, and calculate the adjustable Intercept Point 
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2.4.1.6 Spectrum Monitor 

Display the power of spectrum in color spectrum. Select Spectrum Monitor and press Meas Setup to 

set the corresponding parameters. 

2.4.1.7 Meas Off 

Turn off all the Meas function. 

2.4.2 Meas setup 

2.4.2.1 Channel Power 

 

Figure 2-10 Channel Power 

 

Measurement Results: channel power and power spectral density.  

◆ Channel Power: power within the integration bandwidth.  

◆ Power Spectral Density: power (in dBm/Hz) normalized to 1Hz within the integration bandwidth.  

 

Measurement Parameters: Center Freq, integration bandwidth, Span, Span power.  

 

1. Center Freq 

Sets the center frequency, this center frequency which is the same with the center frequency of the 

analyzer. Modifying this parameter will change the center frequency of the analyzer.  

 

2. Integration bandwidth 

Set the frequency width of the channel to be tested and the power of the channel is the power integral 

within this bandwidth. You can use the numeric keys, knob or direction keys to modify this parameter.  
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Table 2-31 Integration BW 

Parameter  Explanation 

Default  2 MHz 

Range  100 Hz ~ Span 

Unit  GHz, MHz, kHz, Hz 

Knob Step  Integration BW/100, the minimum is 1 Hz 

Direction Key Step  In 1-1.5-2-3-5-7.5 sequence 

 

3. Span 

Set the frequency range of the channel. This span which is the same with the span of the analyzer is 

the frequency range of the sweep. Modifying this parameter will change the span of the analyzer.  

The channel power span is related to the integration bandwidth and the range available is from 

integration bandwidth to integration bandwidth×20.  

 

Table 2-32 Channel Power Span for Chan Power Measurement  

Parameter  Explanation 

Default  3 MHz 

Range  100 Hz ~ Span 

Unit  GHz, MHz, kHz, Hz 

Knob Step  Channel Power Span/100, the minimum is 1Hz 

Direction Key Step  In 1-1.5-2-3-5-7.5 sequence 

 

4. Span Power 

Set the integrated bandwidth to the sweep span of display. The channel power and power spectral 

density display on the screen simultaneously.  
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2.4.2.2 ACPR 

 

Figure 2-11 ACPR 

 

Adjacent Channel Power Measurement: Main CH Power, Left channel power and Right channel power.  

◆ Main CH Power: display the power within the bandwidth of the main power  

◆ Left channel power : display the power of left channel and the power difference between the left 

channel and the main channel (in dBc) 

◆ Right channel power: display the power of the right channel and the power difference between the 

right channel and the main channel(in dBc) 

 

Measurement parameter: center frequency, main channel bandwidth, adjacent channel bandwidth 

and channel spacing  

 

1. Center Frequency 

Sets the center frequency, this center frequency which is the same with the center frequency of the 

analyzer. Modifying this parameter will change the center frequency of the analyzer.  

 

2. Main channel bandwidth 

Set the bandwidth of the main channel and the power of the main channel is the power integral within 

this bandwidth. You can use the numeric keys, knob and direction keys to modify this parameter. 

 

 

 

 

Table 2-33 Main channel bandwidth 

Parameter  Explanation 
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Default  2 MHz 

Range  100 Hz ~ Sweep Span 

Unit  GHz, MHz, kHz, Hz 

Knob Step  Integration BW /100, the minimum is 1 Hz 

Direction Key Step  In 1-1.5-2-3-5-7.5  Sequence 

 

3. Adjacent channel bandwidth  

Set the frequency width of the adjacent channels.  

The adjacent channel bandwidth is related to the main channel bandwidth and the range available is 

from main channel bandwidth/20 to main channel bandwidth×20.  

 

Table 2-34 adjacent channel bandwidth 

Parameter  Explanation 

Default  2 MHz 

Range  100 Hz ~ Sweep Span 

Unit  GHz, MHz, kHz, Hz 

Knob Step  Integration BW /100, the minimum is 1 Hz 

Direction Key Step  In 1-1.5-2-3-5-7.5  Sequence 

 

4. Adjacent Channel space 

Set the difference between the center frequency of the main channel and the center frequency of the 

adjacent channels.  

Adjusting this parameter will also adjust the distance between the upper/lower channel and the main 

channel.  

 

Table 2-35 Adjacent channel space 

Parameter  Explanation 

Default  2 MHz 

Range  33 Hz ~ full span 

Unit  GHz, MHz, kHz, Hz 

Knob Step  Integration BW /100, the minimum is 1 Hz 

Direction Key Step  In 1-1.5-2-3-5-7.5  Sequence 
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2.4.2.3 OBW 

 

Figure 2-12 OBW 

 

OBW measurement: occupied bandwidth and transmit frequency error.  

◆ Occupied Bandwidth: integrate the power within the whole span and then calculate the bandwidth 

occupied by the power according to the specified power ratio.  

◆ Transmit Frequency Error: difference between the center frequency of the channel and the center 

frequency of the analyzer.  

2.4.2.4 T-Power 

 

Figure 2-13 T-Power 

 

T-Power: namely the power of the signal from the start line to the stop line. 

Measurement Parameter: center frequency, start line, stop line. 
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1. Center Frequency 

Sets the center frequency, this center frequency which is the same with the center frequency of the 

analyzer. Modifying this parameter will change the center frequency of the analyzer.  

 

2. Start line 

Set the left margin (in time unit) of T-Power measurement. The data calculated under this measurement 

is between the start line and stop line. You can use the numeric keys, knob or direction keys to modify 

this parameter. 

 

Table 2-36 start line 

Parameter  Explanation 

Default  1ms 

Range  0 s ~ stop line 

Unit  ks, s, ms, us, ns 

Knob Step  Sweep time/751 

Direction Key Step  In 1-1.5-2-3-5-7.5 Sequence 

 

3. Stop line  

Set the right margin (in time unit) of T-Power measurement. The data calculated under this 

measurement is between the start line and stop line. You can use the numeric keys, knob or direction 

keys to modify this parameter. 

 

Table 2-37 stop line 

Parameter  Explanation 

Default  24.032ms 

Range  Start line ~ sweep time 

Unit  ks, s, ms, us, ns 

Knob Step  Sweep time /751 

Direction Key Step  In 1-1.5-2-3-5-7.5 Sequence 
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2.4.2.5 TOI 

 

Figure 2-14 TOI 

 

TOI is automatic measurement; do not need to set parameters. 

2.4.2.6 Spectrum Monitor 

 

Figure 2-15 Spectrum Monitor 

 

Display the power of spectrum in color spectrum. 

Spectrogram: Sets the meas state of spectrum monitor.  
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2.5 System 

2.5.1 System 

Set the system parameters.  

2.5.1.1 Language  

The analyzer supports multi-language menu, Chinese and English build-in help and popup messages.  

Press this key to select the desired display language.  

2.5.1.2 Power On/Preset 

1. Power On 

Set the power on setting to Default, Last or one of user. 

◆ Def: Load the default settings, for more details please refer to Table 2-40. 

◆ Last: When Last is selected, settings before the last power-off would be recalled automatically at 

power on.  

◆ User: If power on set to user, the device will recall the specified configuration after power on.  

 

2. Preset  

Set the preset type to Default, Last or one of User.  

◆ Def : When press Preset, load the default settings, for more details please refer to Table 2-40. 

◆ Last: When press Preset, load the last power-off settings.  

◆ User : When press Preset, load the specified configuration type.  

 

3. User Config 

Save the current instrument setting as user-defined setting into the internal non-volatile memory.  

  

4. Factory 

When factory is selected, the device will recall the initial config.  

 

5. Reset & Clear 

When Reset & Clear is selected, the device will recall the initial config and all user data and settings 

will be erased. 

2.5.1.3 Interface Config 

The analyzer supports communications through LAN, USB and USB-GPIB as standard interface. 

 

1. LAN  
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Config or reset related parameters of LAN. As default, the IP config is DHCP. 

 

Figure 2-16 Static IP Config 
 

2. GPIB 

Config GPIB port number. The analyzer provides a USB-GPIB port on the front board. 

2.5.1.4 Calibration 

Auto Cal  

When Auto Cal opens, the analyzer will process self-calibration regularly. Within half an hour after 

power-on, the device executes a self-calibration every 10 minutes.  

2.5.1.5 System Info 

1. System Info  

◆ Product Model, Serial and HOST ID 

◆ Software Version and Hardware Version 

◆ Option Information 

 

Figure 2-17 System Info 

2. Load Option 

Load license, enter license here to load options. 
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3. Firmware Update 

Update firmware from .ADS file in storage. After firmware updated, the analyzer will be reboot. 

2.5.1.6 Data and Time 

Display the data and time On or Off. The system time is displayed in “ymd”, “mdy”, “dmy” format in user 

interface.  

2.5.1.7 Self Test 

1. Screen Test  

Test whether the screen has a dot defect using five colors: White, Red, Green, Blue and Black. Press 

any key to switch the screen color and exit the test.  

 

2. Keyboard Test 

Enter the keyboard test interface. Press the function keys at the front panel one by one and observe 

whether the corresponding key is checked. If not, an error may have occurred in that key. To exit the 

test, press “<-“four times.  

 

3. LCD Test 

If the keys at the front panel are transparent, when the key is pressed, the corresponding backlight will 

turn on when testing it. 

2.5.2 Display 

1. Display Line  

Open or Close Display Line or move the location.  

 

Table 2-38 Grid brightness 

Parameter  Explanation 

Default  0 dBm 

Range  REF Level + REF Offset – 10*Scale/Div ~  

REF Level + REF Offset 

Knob Step  1 dB 

Direction Key Step  10 B 

 

2. Grid brightness 

Control the display grid brightness. 

 

Table 2-39 Grid brightness 
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Parameter  Explanation 

Default  30% 

Range  0 ~ 100% 

Unit  None 

Knob Step  1% 

Direction Key Step  1% 

 

3. Screen Text 

Open or close the current parameter and its value in the wave area. 

 

4. Screenshot 

Select the screenshot type to normal and color inverse. 

The color of trace is not inversed in inverse mode. 

2.5.3 File 

2.5.3.1 Browser 

Browser type including “Dir” and “File”,  

Dir: when selected, use the knob or direction keys to browser directory in system 

File: when selected, use the knob or direction keys to switch among files or folders under the current 

directory.  

2.5.3.2 Open/Load 

Open the current folder or load current file 

2.5.3.3 View Type 

User can define the file type be browsed, included “All Type”, “STA”, “TRC”, “COR”, “CSV”, “LIM”, 

“PIC(JPG/BMP/PNG)”.  

2.5.3.4 Save Type 

User can define the file type be saved, included “STA”, “TRC”, “COR”, “CSV”, “LIM”, “JPG,” 

“BMP”, “PNG”. 

2.5.3.5 Save 

Save file in current directory, the file type is set in "Save Type".  
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An external U disk has the priority to be written in first. 

 

1. STA(Status) 

STA files can be used to save and recall the instrument configuration. They are saved in binary 

format, which is designed to be used by the analyzer, not read by humans. 

 

2. TRC(Trace) 

TRC files store the active (visible) trace data and scaling factors that were in place when the data 

was saved. They are saved in binary format, which is designed to be used by SSA3X instruments, 

not read by humans. 

NOTE: When you first recall trace files, the instrument will adjust the display parameters 

(horizontal and vertical scaling, for example) to match the settings used during data collection. The 

trace data will not change, even if you adjust the parameters. 

 

3. COR(Correction) 

COR files store the data used to mathematically adjust the displayed input signal based on 

external factors (Cable loss, Amplifier/Antenna gain, etc.). They are saved in ASCII format, which 

can be read by humans.  

 

4. CSV(Comma-Separated Variable) 

CSV files store instrument configuration (scaling, units, etc..) and raw data (amplitude and 

frequency values) in ASCII format, commonly viewed in spreadsheet programs like Microsoft® 

Excel®. This file type can be read by humans. 

 

5. LIM(limit) 

LIM files store the line or point data used to configure and display lines used for visual indication of 

a user-defined limit. This is a binary file intended for use with SSA3X instruments and is not 

readable by humans. 

 

6. BMP(Bitmap)/JPG(JPEG)/PNG 

Picture files capture the display of the instrument (screenshot) as an image file. All of the details of 

the display are captured exactly. What you see on the display is in the file. These are readable 

using image programs. 

2.5.3.6 Create Folder 

Create a new folder in current directory. 

2.5.3.7 Operate 

Open/Load: Open the selected folder or directory, Load the selected file. 

Select All: Select all the files in current directory 

Cut: Cut the Selected file or folder, and delete the primary one after paste. 

Copy: Copy the Selected file or folder for paste. 
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Paste: Paste the file cut or copied before into the current. 

Delete: Delete selected file or directory. 

Rename the selected file or folder.   
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2.6 Shortcut Key 

2.6.1 Preset 

Recall the preset setting and restore the analyzer to a specified status.  

◆ Press System ->Pwr On/Preset ->Preset to select “Def”, “Last” or “User”. 

◆ Press Preset to load the factory settings listed in the following table (except items marked with “**”) 

or User-defined settings. 

 

Table 2-40 Factory Settings 

Parameter  Default  

Frequency 

Center Freq 1.6 GHz 

Start Freq 0 Hz 

Stop Freq 3.2 GHz 

Freq Step Auto 

Span 

Span 3.2 GHz 

X Scale\ Linear 

Amplitude 

Ref Level 0 dBm 

Attenuator Auto, 20 dB 

Preamp Off 

Units dBm 

Scale/Div 10 dB 

Scale Type Log 

Ref Offset 0 dBm 

Corrections Off 

BW 

RBW Auto, 1 MHz 

VBW Auto, 1 MHz 

VBW/RBW 1 

Avg Type Log Pwr 

Filter Gauss 

Sweep 

Sweep Time Auto 

Sweep Rule Speed 

Sweep Continue 

Sweep Mode Auto 

Numbers 1 

Trig 
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Trigger Type  Free Run 

Video Trigger 0 dBm 

External Trigger Rising 

TG 

TG Off 

TG Level -20 dBm 

TG Lvl Offset 0 dB 

Normalize Off 

Norm Ref Lvl 0 dB 

Norm Ref Pos 100% 

Ref Trace Blank 

Trace 

Select Trace A 

Trace Type of Trace A Clear Write 

Avg Times 100 

Variable X A 

Variable Y B 

Constant 0 dB 

Output Z C 

Math Type Off 

Detect 

Select Trace A 

Detect Type of Trace A Pos Peak 

Limit 

Limit1 Off, Limit Upper, 0 dBm 

Limit2 Off, Limit Lower, -100 dBm 

Test Stop 

Fail to stop Off 

Buzzer Off 

X Axis Freq 

Demod 

Demod Mode Close 

Earphone Off 

Volume 6 

Demod Time 5.00 s 

Marker 

Select Marker 1 

Select Trace A 

Marker Type Normal 

Delta Pair Delta 

Relative To Off 

Marker Table Off 

Marker Fn 
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Select Marker 1 

Marker Fn Off 

N dB BW -3 dB 

Read Out Frequency 

Peak 

Cont Peak Off 

Peak Table Off 

Peak Threshold -160 dBm 

Peak Excursion 15 dB 

Peak Type Max 

Mode 

Mode Spec Analyzer 

Measure 

Meas Type Off 

Measure Setup 

Channel Power 

Center Freq 1.6 GHz  

Integration BW 2 MHz 

Span 3.2 GHz 

ACPR 

Center Freq 1.6 GHz 

Main Channel 1 MHz 

Adjacent Chn 1 MHz 

Adj Chn Space 3 MHz 

Occupied BW 

Method % 

dBc 26 

% 99 

T-Power 

Center Freq 1.6 GHz 

Start Line 0 s 

Stop Line 20 ms 

System** 

Language English 

Power On Def 

Preset Def 

IP Config DPCH 

Auto Cal Close 

Date & Time On 

Set Format ymd 

Display** 

Display Line Off, 0 dBm 

Grid Brightness 30% 
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Screen Text On 

Screenshot Inverse 

2.6.2 Couple 

Set related parameters according to the coupling relationship. 

Auto all: Set Related parameters automatically according to the coupling relationship. 

 

1. RBW  

RBW have couple relationship with span. Please refer to the introduction of the "Resolution 

Bandwidth". 

 

2. VBW  

VBW have coupling relationship with VBW. Please refer to the introduction of "VBW".  

 

4. Attenuation  

Input attenuation has coupling relationship with Ref Level, preamp. Please refer to introduction of the 

"amplitude". 

 

5. Freq step 

Freq step have coupling relationship with RBW at the zero span, when in none-zero mode, Freq step 

have coupling relationship with Span. please refer to the introduction of the "Freq Step". 

 

6. Sweep time 

Sweep time have coupling relationship with RBW, VBW and span. Please refer to the introduction of 

"Sweep Time". 

2.6.3 Help 

After press Help, press any key to show help information. Press Help second time to close help 

information 

2.6.4 Save 

Quick saving a file, according to “File->Save Type” settings. 

Default file type is “PNG” 
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Chapter 3 Remote Control 

The SSA3000X Series Spectrum Analyzer support LAN, USB Device, and GPIB--USB Host 

interfaces. By using these interfaces, in combination with programming languages and/or NI-VISA 

software, users can remotely control the analyzer based on SCPI (Standard Commands for 

Programmable Instruments) command set, and interoperate with other programmable 

instruments.  

This chapter introduces how to build communication between the spectrum analyzer and a 

controller computer with these interfaces. 

 

3.1 Remotely Operating the Analyzer 

The analyzer provides both the USB and LAN connection which allows you to set up a remote 

operation environment with a controller computer. A controller computer could be a personal 

computer (PC) or a minicomputer. Some intelligent instruments also function as controllers. 

3.1.1 Connecting the Analyzer via the USB Device port  

Refer to the following steps to finish the connection via USB-Device: 

1. Install NI-VISA on your PC for USB-TMC driver. 

2. Connect the analyzer USB Device port to a PC with a USB A-B cable. 

 

3. Switch on the analyzer 

The analyzer will be detected automatically as a new USB hardware.  

 

3.1.2 Connecting the Analyzer via the LAN port  

Refer to the following steps to finish the connection via LAN: 

1. Install NI-VISA on your PC for VXI driver. Or without NI-VISA, using socket or telnet in 

your PC’s Operating System.  

2. Connect the analyzer to PC or the local area network with a LAN cable  
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3. Switch on the analyzer  

4. Press button on the front panel System →Interface→LAN to enter the LAN Config 

function menu. 

5. Select the IP Config between Static and DHCP 

◆ DHCP: the DHCP server in the current network will assign the network parameters 

automatically (IP address, subnet mask, gate way) for the analyzer. 

◆ Static: you can set the IP address, subnet mask, gate way manually. Press Apply. 

 

The analyzer will be detected automatically or manually as a new LAN point. 

 

3.1.3 Connecting the Analyzer via the USB Host port 

Refer to the following steps to finish the connection via USB: 

1. Install NI-VISA on your PC for GPIB driver. 

2. Connect the analyzer USB Host port to a PC’s GPIB card port, with SIGLENT 

USB-GPIB adaptor. 

 

3. Switch on the analyzer 

4. Press button on the front panel System→Interface→GPIB to enter the GPIB number. 

The analyzer will be detected automatically as a new GPIB point. 
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3.2 Build Communication 

3.2.1 Build Communication Using VISA  

NI-VISA includes a Run-Time Engine version and a Full version. The Run-Time Engine version 

provides NI device drivers such as USB-TMC, VXI, GPIB, etc. The full version includes the 

Run-Time Engine and a software tool named NI MAX that provides a user interface to control the 

device.  

You can get NI-VISA full version from:   

http://www.ni.com/download/. 

After download you can follow the steps below to install it:  

a. Double click the visa_full.exe, dialog shown as below: 

 

 

b. Click Unzip, the installation process will automatically launch after unzipping files. If your 

computer needs to install .NET Framework 4, its setup process will auto start. 

 

 

c. The NI-VISA installing dialog is shown above. Click Next to start the installation process. 

http://www.ni.com/download/
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Set the install path, default path is “C:\Program Files\National Instruments\”, you can change it. 

Click Next, dialog shown as above. 

 

 

d. Click Next twice, in the License Agreement dialog, select the “ I accept the above 2 License 

Agreement(s).” ,and click Next, dialog shown as below: 

 

 

e. Click Next to run installation. 
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Now the installation is complete, reboot your PC. 

 

3.2.2 Build Communication Using Sockets/Telnet 

Through LAN interface, VXI-11, Sockets and Telnet protocols can be used to communicate with 

the spectrum analyzer. VXI-11 is provided in NI-VISA, while Sockets and Telnet are commonly 

included in PC’s OS initially. 

Sockets LAN is a method used to communicate with the spectrum analyzer over the LAN interface 

using the Transmission Control Protocol/Internet Protocol (TCP/IP). A socket is a fundamental 

technology used for computer networking and allows applications to communicate using standard 

mechanisms built into network hardware and operating systems. The method accesses a port on 

the spectrum analyzer from which bidirectional communication with a network computer can be 

established. 

Before you can use sockets LAN, you must select the analyzer’s sockets port number to use: 

◆ Standard mode. Available on port 5025. Use this port for programming. 

◆ Telnet mode. The telnet SCPI service is available on port 5024. 
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3.3 Remote Control Capabilities 

3.3.1  User-defined Programming  

Users can use SCPI commands to program and control the spectrum analyzer. For details, refer 

to the introductions in “Programming Examples”.  

3.3.2  Send SCPI Commands via NI MAX  

Users can control the spectrum analyzer remotely by sending SCPI commands via NI-MAX 

software.  

3.3.2.1 Using USB  

Run NI MAX software. 

1, Click “Device and interface” at the upper left corner of the software; 

2, Find the “USBTMC” device symbol  

 

 

3, Click “Open VISA Test Panel” option button, then the following interface will appear.  

4, Click the “Input/Output” option button and click the “Query” option button in order to view the 

operation information. 

 

 

 

NOTE: The *IDN? command (known as the Identification Query) returns the instrument 

manufacturer, instrument model, serial number, and other identification information. 
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3.3.2.2 Using LAN  

Select, Add Network Device, and select VISA TCP/IP Resource as shown: 

 

Run NI MAX software. 

1, Click “Device and interface” at the upper left corner of the software; 

2, Find the “Network Devices” symbol; click “Add Network Devices”; 

 

 

3. Select Manual Entry of LAN instrument, select Next, and enter the IP address as shown. Click 

Finish to establish the connection: 

 

 

NOTE: Leave the LAN Device Name BLANK or the connection will fail. 
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4. After a brief scan, the connection should be shown under Network Devices: 

 

 

5. Right-click on the product and select Open NI-VISA Test Panel: 

 

 

6. Click “Input/Output” option button and click “Query” option button. If everything is OK, you will 

see the Read operation information returned as shown below.  

 

 

3.3.3 EasySpectrum Software  

Users can control the spectrum analyzer remotely by EasySpectrum. PC software 

EasySpectrum is an easy-to-use, PC-Windows-based remote control tool for Siglent’s spectrum 

analyzer. You can download it from Siglent’s website. To connect the analyzer via the USB/LAN 

port to a PC, you need install the NI VISA first. 

 

It is able to be used as: 

◆ A monitor to display and control the trace scans simultaneously with the analyzer; 
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◆ A file maker to get user defined Limit/Correction files, and load them to the analyzer; 

◆ An EMI receiver to perform EMI Pre-compliance test including pre scan, peak search, final 

scan and report generating. 

 

For the further description of the software, please refer to the online help embedded in this 

software.  
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Chapter 4 Troubleshooting and Service 

4.1 Service Summary  

SIGLENT warrants that the products that it manufactures and sells will be free from defects in materials 

and workmanship for a period of three years (accessories for a period of one year) from the date of 

shipment from an authorized Siglent distributor. If the product proves defective within the respective 

period, SIGLENT will provide repair or replacement as described in the complete warranty statement. 

To arrange for service or obtain a copy of the complete warranty statement, please contact your 

nearest Siglent sales and service office. Except as provided in this summary or the applicable warranty 

statement, SIGLENT makes no warranty of any kind, express or implied, including without limitation the 

implied warranties of merchantability and fitness for a particular purpose. In no event shall SIGLENT be 

liable for indirect, special or consequential damages. 

 

4.2 Troubleshooting  

Before calling SIGLENT, or returning an analyzer for service, perform the quick checks listed below. 

This check may eliminate the problem. 

If the problem remains still, please contact SIGLENT and provide your device information in the back of 

the analyzer.  

1． The Power Switch  is still dark after power on:  

(1) Check: whether the power supply is according to 1.3.2; 

(2) Check: the power has been connected correctly; 

(3) Check: whether the power fuse is burned. If a new fuse needs to be installed, please use a 

specified fuse. 

 

2． The analyzer’s screen is still dark (no display) after power on: 

(1) Check: whether the fan is running while the screen is dark, maybe the LCD cable is loose; 

(2) Check: whether the fan is not running while screen is dark, maybe it has failed to start up; 

    Do not disassemble the instrument by yourself and contact SIGLENT. 

 

3． The key is unresponsive or gives a wrong response:  

(1) Press all the keys at the front panel to check if all of them are normal after power on.  

(2) Press System ->Self Test ->Key Test to check if all the keys are working properly.  

(3) If a key is not working, the numeric keyboard connection might be loose or the numeric 
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keyboard is broken.  

Do not disassemble the instrument by yourself and contact SIGLENT. 

 

4． The spectrum lines on the screen do not update for a long period of time:  

(1) Check whether the screen is locked; if so, press Esc to unlock it.  

(2) Verify whether all the trigger conditions have been met and whether there is a valid trigger 

signal inputting.  

(3) Check whether the analyzer is in single sweep.  

(4) Check whether the current sweep time is too long.  

 

5． Wrong measurement results or poor precision:  

To calculate the system errors and check the measurement results and precision, refer to the 

introductions in “Specifications”. To reach these specifications, please:  

(1) Check whether all the external devices are successfully connected and are working normally.  

(2) Get some knowledge of the signal under measurement and set appropriate instrument 

parameters.  

(3) Make measurements under proper conditions; for example, warm-up the instrument 

appropriately and operate the instrument under the specified environment temperature.  

(4) Calibrate the instrument regularly to reduce or avoid errors that might occur over time.  

 If you need a specific calibration after the stated calibration period, contact SIGLENT or get paid 

service from authorized measurement agencies.  

 

6． Pop-up Message:  

The instrument may display prompt messages, error messages or state messages according to the 

current working status. These messages are displayed to help you to use the instrument correctly and 

are not instrument failures.  
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4.3 Contact Us 

China: 

SIGLENT TECHNOLOGIES CO., LTD. 

Add: Bldg No.4 & No.5, Antongda Industrial Zone, 3rd Liuxian Road, Bao'an District,  

Shenzhen, 518101, China.  

Tel: + 86 755 3661 5186 

Fax: + 86 755 3359 1582 

Email: sales@siglent.com;  

Website: http://www.siglent.com/ens/ 

 

USA: 

SIGLENT Technologies America, Inc 

6557 Cochran Rd Solon, Ohio 44139 

Tel: 440-398-5800 

Toll Free: 877-515-5551 

Fax: 440-399-1211 

Email: info@siglent.com 

Website: www.siglentamerica.com 

 

Europe: 

SIGLENT TECHNOLOGIES EUROPE GmbH     

ADD: Liebigstrasse 2-20, Gebaeude 14, 22113 Hamburg Germany   

Tel: +49(0)-819-95946 

Fax: +49(0)-819-95947 

Email: info-eu@siglent.com 

Website: www.siglenteu.com 

 

http://www.siglent.com/ens/
http://www.siglentamerica.com/
http://www.siglenteu.com/

